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Notices

Modifications or changes to the SolidLink™ radio,
not expressly authorized by Seimac Limited, could
void the user’s authority to operate the SolidLink™
radio.

This equipment has been tested and found to
comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits
are designed to provide reasonable protection
against harmful interference in a residential
installation. This equipment generates, uses and
can radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee
that interference will not occur in a particular
installation. If this equipment does cause harmful
interference to radio or television reception, which
can be determined by turning the equipment off and
on, the user is encouraged to try to correct the
interference by one or more of the following
measures:

1. Reorient or relocate the receiving antenna.

2. Increase the separation between the equipment
and receiver.

3. Connect the equipment into an outlet on a circuit
different from that to which the receiver is
connected.

4, Consult the dealer or an experienced radio/TV
technician for help.
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Operation of the SolidLink™ radio is subject to the
following two conditions: (1) this device may not
cause interference, and (2) this device must accept
any interference, including interference that may
cause undesired operation of the device.

This device has been designed to operate with an
omni directional antenna having a maximum gain of
6dB, or a directional antenna having a gain of 26dB.
Antenna having a higher gain is strictly prohibited
per regulations of Industry Canada. The required
antenna impedance is 50ohms.

The installer of this radio equipment must ensure
that the antenna is located or pointed such that it
does not emit RF field in excess of Health Canada
limits for the general population; consult Safety
Code 6, obtainable from Health Canada’s website at
www.hc-sc.gc.calrpb.

This device complies with FCC RF radiation
exposure limits; however it is important that the
device be installed such that human exposure to
harmful RF radiation is minimized. In order to
comply with RF exposure limits, the following
minimum separation distances between the
transmitter antenna and all persons should be
maintained:

Omnidirectional 20cm
Directional (Yagi) 2m
High Gain Directional 2m
(Parabolic)

The directional and high gain directional antennas
are for fixed outdoor installations only.
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1 SolidLink Introduction

Seimac’s SolidLink™ industrial radio modem is a
rugged, low power, frequency hopping, 2.4 GHz
spread spectrum radio that reliably transports data
for remote monitoring, telemetry and industrial
SCADA applications. SolidLink combines state-of-
the-art RF and digital design, compact, robust
industrial design, and graphics based network
software for rapid deployment, efficient network
maintenance and long range license free operation.

The SolidLink radio and the SolidLink Network
Manager software, together provide the complete
data communication solution. For the latest
information on SolidLink, please visit
www.solidlinkradio.com.

1.1 Features

SolidLink has been developed to provide industrial
data system developers and users with a full-
featured industrial radio network provi ding:

1. arugged, weatherproof, outdoor deployable
package;

2. built in CRC error detection and automatic
retransmission to guarantee error free data
transmission through the network;

3. license free operation in the 2.4GHz ISM band;

4, RS-232 serial data interface, operating at
57.6Kbaud without Repeaters and 28.8Kbaud
with Repeaters;

Page 4
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5. simple network development, configuration and
deployment through the drag-and-drop SolidLink
Network Manager PC application;

6. real-time online network diagnostic and
performance information through the SolidLink
Network Manager;

7. point-to-point and point-to-multipoint network
topologies, both with and without Repeaters, to
a maximum of 1000 radios per network; and

8. FCC and RSS-210 Industry Canada certification.

1.2 Warranty

Seimac Limited ("Seimac") shall repair or, at its
option, replace, at no cost for labor, materials or
return transportation, SolidLink™ if proven to be
defective within two years from date of first
purchase. No cash refunds. This warranty is
available for first purchasers only.

Warranty does NOT cover replacement parts
normally replaced during warranty term, or, damage
from any of: (1) wear and tear or misuse; (2) failure
to install, use or maintain in accordance with
SolidLink manual; (3) repair or modification done by
anyone other than Seimac or authorized dealer; (4)
failure to adequately package for transit; or (5)
damage by lightning.

To enforce the warranty, obtain a Return
Merchandise Authorization (RMA) number from
Seimac by calling (902) 468 3007 and ship the
SolidLink, prepaid, to:

Page 5
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Seimac Limited

271 Brownlow Avenue,
Halifax, Nova Scotia,
B3B 1W6 Canada

We recommend you retain and use your original
packaging to ensure safe shipping of your
SolidLink™,

THIS IS THE ONLY WARRANTY PROVIDED BY
SEIMAC FOR THE SolidLink™, AND ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING AS TO MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, ARE
EXCLUDED. SEIMAC SHALL HAVE NO LIABILITY
FOR INJURIES, DEATH, PROPERTY DAMAGE OR
OTHER LOSSES OR CLAIMS RELATED TO ANY
USE OF THE SolidLink™, WHETHER CLAIMED AS
INCIDENTAL, SPECIAL, DIRECT, INDIRECT OR
CONSEQUENTIAL DAMAGES. ACTIVITIES
ASSOCIATED WITH USE OF THE SolidLink™ ARE
INHERENTLY DANGEROUS, AND THE
PURCHASER ACCEPTS THE RISK OF THESE
ACTIVITIES.

1.3 About This Manual

This manual is provided as a guide to developing,
installing and operating SolidLink networks. It
includes detailed technical details as well as
introductory information for the first time user.

It is assumed that the user is familiar with the basic
concepts of data communication and free space
radio frequency transmission. While an introduction

Page 6
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to frequency hopping spread spectrum technology is
provided, it should not be considered a tutorial.

Topics covered in this manual include:

1. technical background information on spread
spectrum technology, SolidLink operation, and
network topologies;

Getting Started with SolidLink;

3. SolidLink hardware interface, operation and
installation;

4, the SolidLink Network Manager - the PC
application used to design networks, configure
radios, debug network applications and monitor
performance;

5. system troubleshooting guide;
6. system specifications; and

7. detailed serial command protocols.

Page 7
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2 Overview

This section provides some background technical
information and summarizes the capabilities and
operation of the SolidLink technology. It is
recommended that the reader become familiar with
the material in the following sections before
proceeding:

= Spread Spectrum Technology;
= SolidLink Theory of Operation;
= Network Configurations; and
= SolidLink Network Manager.

2.1 Spread Spectrum
Technology

Traditional RF narrow-band communication
techniques involve modulating a fixed radio
frequency carrier signal with a low frequency signal
that contains the information to be transmitted (refer
to graphic below). Examples in everyday life are
common: commercial AM and FM broadcast,
television broadcast, licensed two-way voice radios,
and cellular telephones. The advantage of this
approach is that the receivers and transmitters can
be fairly simple and need not be synchronized.
Their disadvantage is that they are very susceptible
to interference, and rely on sole access to a specific
segment of the frequency spectrum. For example, it
would be easy to disrupt a two-way voice radio link
by simply transmitting an interfering signal at the
frequency used by the voice link radios.
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Spectrum spreading is simply an approach whereby
the transmitted energy is spread across a relatively
wide band, rather than being concentrated in a very
narrow band. Its advantages and disadvantages are
the converse of narrow band: it is less immune to
interference, but is more complex because the
receiver and transmitter must synchronize. Another
advantage of spectrum spreading is that
transmissions are much less detectable than
narrowband approaches, because the average
energy at any one narrow frequency will always be
much less. Its immunity from interference is so high,
that many spread spectrum radios can operate
effectively in the same physical area, at the same
time. Examples include IEEE 802.11 wireless LAN,
Bluetooth, and cordless telephones.

There are two primary techniques for spreading the
spectrum, direct sequence and frequency hopping.
In a direct sequence system, a fixed carrier signal is
first modulated with the information and then is
further modulated by a fixed pattern pseudo-random
code sequence. The effect of the latter action is to
spread the energy across a wide band (following
graphic). The receiver must demodulate the
broadband signal with the same pseudo-random
data sequence to recover the original modulated
signal.
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In a frequency hopping system, the information is
used to directly modulate the carrier signal; however
instead of using a fixed carrier (as in a narrow band
radio), the carrier frequency is rapidly and
predictably altered, following a specific pseudo-
random pattern (called a hop sequence). The
receiver must know the hop sequence, and once it
has synchronized with the transmitted signal, can
adjust its receiver to follow the changes in transmit
carrier. FCC regulations require that the period
between hops be no longer than 400 msec.
SolidLink is a frequency hopping system, with a hop
period of 25 msec.

VYV

The frequency band 2400 MHz to 2483.5 MHz has
been set aside in most countries, including the
United States, Canada and Europe, for unlicensed
spread spectrum radio operation.

2.2 SolidLink Theory of Operation

The following graphic illustrates the high level
hardware functions of the SolidLink radio. An on-
board micro-controller controls the overall radio
operation. Firmware revisions can be downloaded
into the radio by the user through the SolidLink
Network Manager. SolidLink has two connectors. A
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TNC Female connector provides a 50 interface to
the antenna cable, used for both transmit and
receive. In internal switch ensures that the
transmitter and receivers remain isolated. An EN3
circular connector provides both 10-26 VDC power
to the radio and provides RS -232 data and control
signals.

. o

SolidLink pl Transmitier

? }74
RF
Receiver |4

Modem
Data #
ot on el cooe e TP
DC
> S/

For further information refer to the Serial Data
Interface, Radio Interface, and Operating Mode
sections.

2.2.1 Serial Data Interface

SolidLink accepts RS-232 data through the EN3
circular connector. Details of the communication
protocol are provided in Command Protocol section.
Hardware flow control signals are provided. For
incoming data, the controller breaks the stream into
packets which will fit within the 25 msec hop window.
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The maximum number of user data bytes in a packet
is 288. If data arrives in bursts, the controller will
send a partially complete packet at the next hop.

For outgoing data, the controller receives packets
destined for that radio’s serial port, strips off the
packet header information, and sends the data
payload out the RS-232 data port. It is important to
note that, while serial data may enter one radio in a
very continuous manner, it will leave another radio in
bursts.

2.2.2 Radio Interface

As discussed in the Spread Spectrum Technology
section, all frequency hopping spread spectrum
radios must incorporate a known hop sequence, so
that the transmitter and receiver can synchronize.
SolidLink includes five hop tables; the user selects,
which is used when the configuration is downloaded
into the radio via the SolidLink Network Manager.
Any radios that communicate directly with each other
must be configured to use the same hop table.

Before any radios can communicate, they must
establish hop synchronization. One and only one
radio in the network must be configured as a Master.
It periodically (nominally every four seconds)
transmits a synchronization packet which is unique
and which those radios that receive it can use to
synchronize to the hop sequence. The sync packet
is propagated through the network by all Repeaters
so that all radios in the network can synchronize. If
any one radio looses sync, it will wait no longer than
four seconds before it can regain synchronization.
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The data payload is transmitted inside a packet,
which includes source and destination address
information in a header (refer to above graphic).
Before transmission, a CRC is calculated and
appended to the packet. Upon receipt the CRC is
recalculated. If the two values do not match, then
the receiver returns a negative acknowledgement to
the transmitting radio at the next opportunity, and
the packet is re-transmitted. The user can configure
the radios with the maximum number of retries. If
the two values match, then the receiver returns a
positive acknowledgement to the transmitting radio
during the next opportunity; and the transmitter
discards the original packet. In this way, data is
delivered without error through the network.

In some applications, the overall data volume may
be small and low power operation may be important.
A network of SolidLink radios can be configured to
go to sleep periodically to save power. Because
their individual clocks are not synchronized, the
radios will awaken at slightly different times. The
maximum time they can remain asleep and ensure
that they can regain sync when they wake is TBD
minutes. Once it awakens, the Master begins
transmitting sync packets, which propagate through
the network as the individual radios awaken.

Page 13
© 2003 by Seimac Limited, All Rights Reserved



SolidLink SS2400S Operators Manual
18 September 2003 Version DRAFT

2.2.3 Operating Modes

At any one time a SolidLink radio operates in one of
two modes: data or command. In data mode it
operates as a data pipe:

= Data received at the serial port is packetized
and transmitted on the RF port;

= Data received for the radio at the RF port is
extracted from the packet and transmitted out
the data port; and

= In the case of Repeaters, packets received at
the RF port and not destined for the radio are
retransmitted to the next radio, as per its packet
routing table.

In command mode, the SolidLink radio accepts a
series of AT style commands at the serial port.
Refer to the Commands section, which describes
these in detail. In summary they support:

= Creating and terminating a connection between
two radios;

= Obtaining ID and version information about the
radio;

= Obtaining diagnostic information about the radio
and network; and

= Leaving command mode and entering data
mode.
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By default a radio is in data mode. Entering
command mode is accomplished by driving the CME
serial interface control line low and then issuing an
ATEC command; this is described in more detail in
the Command Mode section.

The SolidLink radio also supports configuration and
firmware reprogramming; however these interfaces
are provided to the user through the SolidLink
Network Manager.

2.3 Network Configurations

A SolidLink network consists of from 2 to 1000
SolidLink radios. A radio can be configured to
operate as one of three different types: a Master, a
Repeater or a Remote. It is important to note that
there is no physical difference between these radios;
it is simply a matter of how it is configured by the
SolidLink Network Manager.

2.3.1 Radio Types

Each network must have one Master and can have
no more than one Master. The Master must be
either the source or destination for all information
flow. A Master can connect to any number of
Repeater and/or Remote radios and is at the
upstream end of the network. Typically the serial
interface of the Master is connected to a computer of
some sort which executes the user’s application
software.
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Remote radios can connect to only one other radio;
they are at the extreme downstream end of the
network. They typically interface with a Remote
Terminal Unit (RTU), sensor device some other
piece of remote equipment.

Repeaters can operate as Remotes, in that their
serial interface connects to an RTU or other device.
However, the Repeater can connect to more than
one radio, and includes the capability to route
packets not addressed to it. As part of their
configuration, Repeaters include a routing table
which instructs them where to send information
being routed through.
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The above graphic shows a simple SolidLink
network comprising of four radios. Radio 1 is
configured as the Master, radio 2 is a Repeater, and
radios 3 and 4 are configured as Remote nodes.
Through the Master, the user’s application on the
data host can communicate bi-directionally with any
of the three RTUs. The RTUs cannot communicate
with each other; all information must flow through
the Master.

2.3.2 Network Types

Networks can be very complex. There can be many
Repeaters and many network levels. Repeaters
could be strung out along a line, such as along a
pipeline or a river. The network could also be
hierarchical, where one Master communicates with
several Repeaters, each of which communicates
with several Repeaters, and so on. In either case,
all radios are addressable through the Master.

The network topology is fixed when the network is
designed (using the SolidLink Network Manager)
and downloaded into the radios. If the user wishes
to change the topology, for example by adding a
node, then the Master and all routers affected must
be reconfigured.

SolidLink supports two different types of networks
point-to-point and point-to-multipoint. The network
type is established when the network is designed,
using the SolidLink Network Manager.
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Ina point-to-point network all communication is
strictly controlled by the Master. The user’s
application on the data host will establish a channel
between the Master and another radio by putting the
Master into command mode and then using an
ATDT command to make the link. For example, the
graphic below, channels could be established
between the Master and radio’s 2,3 or 4. Until the
connection is terminated (with an ATHO command),
all serial data that flows into the Master will flow out
of the serial port of the connected radio. Similarly all
serial data that flows into the connected radio will
flow out of the Master. Radios that are not
connected, will not transmit data. Each contains a
4096 Kbyte serial data buffer for holding data until a
connection is made by the Master radio.

. RTu
r
— -
2 3
5 [ [
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A point-to-multipoint network provides the same
capability for connection based operation as does
the point-to-point network. In addition, serial data
from unconnected radios will be transmitted to the
serial port of the Master radio. This latter method is
significantly less efficient (from a throughput
perspective) than the connection based method,
because it relies on an internal (to the SolidLink
network) arbitration scheme that is optimized for
small, relatively infrequent, exception data. Point-to-
multipoint also supports a broadcast connection,
whereby any serial information entering the Master
is replicated at the serial port of every other radio.

2.4 SolidLink Network Manager
Software

The SolidLink Network Manager is a PC based
application that is used to design networks,
configure radios, debug applications, and support
ongoing maintenance. It is more completely
described in the SLNM software section. It makes
no special demands of the PC other than requiring a
serial port for configuring the radios. It is available
on CD ROM and can also be downloaded fom the
SolidLink web site: www.solidlinkradio.com.
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The network designer uses drag and drop
techniques to graphically create a network, much
like they would use a drawing tool such as Microsoft
Visio to create a block diagram. Multiple networks
can be create and are stored in a database file.
Each radio in the network must be configured prior
to use. This is easily accomplished by connecting
the radio to the serial port of the PC and selecting
configure from the command menu.

The real value of the SolidLink Network Manager
can be seen when the user wishes to debug or
maintain a new application. It actually comprises of
three components, which execute independently: the
network manager, a terminal window, and a router.
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As illustrated in the above figure, the router can sit
between the user’s application (which would
normally connect to the Master radio), and the
Master radio. This does not affect the flow of
information between the data host and the Master.
It does allow the user to:

Application

= Request online diagnostics of any radio on the
network and display the results;

=  Watch the flow of information (bidirectional) in a
terminal window;

= Log the information flow (bidirectional) to a log
file; and

= Temporarily pause the data host interface and
communicate with the Master directly through
the terminal window.
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3 Getting Started

This section of the manual provides a step-by-step
approach to getting started with SolidLink by building
and bench testing a simple two radio network. If
problems persist during this exercise, contact
Seimac’s technical support specialists at (902) 468-
3007.

To proceed with this exercise refer to Bits and
Pieces.

3.1 Bits and Pieces

The following SolidLink components should be
ordered from Seimac Limited:

=  Two SolidLink industrial radio modems;

=  Two 2.2 dBi rubber duck antennas;

= Two power-data cables;

= One SLNM CD; and

= One SolidLink Manual (this document).

In addition, this test requires the following additional
equipment:

= Two power supplies, capable of providing
between 10 and 26 VDC at 500mA; and

= Two PCs with serial ports capable of hardware
handshake.
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To begin:

Unpack the SolidLink components and ensure
everything is there and that nothing was damaged.

To proceed refer to Installing the SolidLink Software

3.2 Installing the SolidLink
Software

Before the network can be created, the SolidLink
Network Manager must be installed.

To install:

1. Determine which PC will be used as the network
manager, the operating system must be
Windows 98, NT, 2000, or XP.

2. Remove the SolidLink CD and insert into the CD
reader of the network manager PC.

3. Follow the instructions to install the software; it
uses the standard windows install shield.

4. If the computer is not restarted, it will be
necessary to manually start the router, do this by
selecting the Router item under the Seimac
SolidLink Network Manager entry in the program
menu. The router will automatically start each
time the computer is started and the user logs
on.

5. Start the SolidLink Network Manager. The first
time that the program is run, the user will be
prompted to create the network database file,
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that will hold the designed networks. By default,
the file will be called Network.tdb.

To proceed continue to the Creating the Network
section.

3.3 Creating the Network

The next step is to create a simple network:

1. Select File | New Network to create a new
network.

2. A Network Properties dialog box will appear.
Enter a network ID, defaults are fine for other
values. These values can be changed at any
time through Network | Properties.

3. Select Tools | Master Radio and then click
anywhere on the canvas, a Master radio icon will
appear. lIts ID number (1) will be displayed
above.

4. Select Tools | Remote Radio and then click
anywhere on the canvas, a Remote radio icon
will appear. Its ID number (2) will be displayed
above.

5. Select Tools | Straight Connector and draw a
line between the two radios.

6. Select Tools | Selection Tool and then select the
Master Radio.

7. Select Radio | Properties, a Radio Properties
dialog box will appear.

8. Adjust the serial port protocols to match the PC
to be used with it and adjust the RF output to
100 mW. Click OK.
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9. Repeat Instructions 6,7, and 8 for the Remote
Radio.

10. Select File | Save Network, a dialog box
confirming a successful save will appear.

To proceed refer to the Configuring the Radios
section.

3.4 Configuring the Radios

Before turning the network on, the radios must be
configured.

1. Connect the serial / power cable to the circular
connector on the Master Radio

2. Connect the serial cable to the appropriate COM
port of the Network Manager PC, the default
serial configuration of the radio is 57600-N-8-1.
The radio requires that the COM port support
hardware flow control.

3. Connect the +/- power leads to an 10-26 VDC
supply and apply power to the SolidLink radio.
The red LED will illuminate to indicate that the
radio has power.

4, Select Router | Connect to Router. If this
element is gray, then the router is not running.
To activate the router select Programs | Seimac
SolidLink Network Manager | Router and then
try connecting to the router.

5. Select Router | Manually Select Router COM
Settings and ensure that the settings are 57600-
N-8-1 (the SolidLink radio default). The Radio
COM port selection must match the port into
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which the radio was connected in Instruction 2
(e.g. COM1).

Select the Master Radio by clicking on the
network diagram.

Select Radio | Configure. The SolidLink
Network Manager will verify the connection to
the radio. Configuring the radio takes less than
30 seconds. During that time the status will be
displayed on the status bar and a progress bar
will be added to the bottom of the window to
display progress.

Repeat steps 1,2,3,6, and 7 for the Remote
Radio.

To proceed refer to the Testing the Network section.

3.5 Testing the Network

Once the radios have been configured, and are
powered the Master will transmit sync packets every
four seconds and the Remote will attempt to
synchronize.

1.

Separate the radios by approximately 5 feet and
attach the 2.2 dBi omni antennas to the TNC
connector. The green light on the Remote radio
will turn on solid when the radios are in sync.

Connect a PC to the serial cable of the Remote
Radio.

Configure the PC serial port to match the
Remote Radio: 57600-N-8-1 with hardware flow
control.
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10.

Use Microsoft Hyper-terminal or similar terminal
window application to connect directly to the PC
serial port, ensure that the port settings remain
correct. This will provide a mechanism to send
data into the Remote Radio and to view the data
received by the Remote Radio.

Connect the Master Radio serial cable to the
network manager PC serial port.

Select "Tools" | "Open Terminal Window" to
create a SLNM terminal window to watch serial
traffic on the Master Radio.

Select "Tools" | "Put Radio in Command
Mode".

Enter “ATDT0002” in the data entry window of
the terminal window and then press “Send”.
This will create a connection between the
Master and the Remote.

Enter “ATQ" in the data entry window of the
terminal window and then press “Send”. This
will terminate command mode and return the
Master Radio to data mode.

Information typed into the Hyper-terminal
window attached to the Remote Radio will
appear in the SLNM terminal window (in red).
Information typed into the data entry window of
the SLNM terminal window will appear on the
Hyper-terminal window.

Congratulations!
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4 SolidLink Hardware

The SolidLink radio modem is packaged in a
weatherproof enclosure suitable for mounting either
inside or outside an enclosure. The main housing is
an aluminum extrusion, which is coated with a
marine epoxy paint. The end caps, which are rubber
over molds over stainless steel inserts, provide a
weather proof seal to each end of the extrusion.
Stainless steel screws are sealed with o-rings, and
should be torqued to TBD ft-lb to properly seal the
end caps.

Internally, the electronics consist of a two board set.
A radio board includes the 1W spread spectrum
transmitter, receiver, modem and controller. A
carrier board includes I/O protection, level control
and DC power regulation.
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There are four major elements visible on the outside
of the enclosure:

1
2
3.
4

Indicator lights;
RF connector,

Power-Data connector; and

Slidable mounting nuts (bottom view).

4.1 Light Indicators

This group of three light emitting diodes (LEDs),
provides a graphical status indication of the
SolidLink radio modem state.
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The LED descriptions are as follows:

RED LED (Power)

Indicates that DC power applied. The SolidLink
radio accepts DC power between 10 and 26 Volts.

GREEN LED (Lock)

Indicates the synchronization status. The Master
Radio LED remains lit while the radio is powered on.
The Green LED on Remote and Repeater radios
remains unlit until it synchronizes with its upstream
radio. If a radio at any time looses synchronization
with the network, then the Green LED will go out
until synchronization is reestablished.
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YELLOW LED (Data Transmit Activity)

This light indicates that data is currently being
transmitted by the radio. In general, the led flickers
as data flows out of the unit, over the air.

4.2 Connectors

RF Connector

This connector is a TNC Female connector used to
connect the SolidLink radio modem with different
external antennas. Proper rules and regulations
must be followed when attaching external antennas;
antenna installation is discussed in the Antenna and
Cable Connection section.

Power-Data Connector

The power-data connector is an EN3 type
weatherproof connector. It provides both DC power
and the RS-232 serial data interface. A variety of
cables with proper matching connectors are
available from Seimac Limited. Pin 1 is in the first
counter-clockwise position from the key. Pin 8 isin
the center.
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The following table describes the pin-out for the EN3

circular connector:

PIN Number Signal Name Description
1 Spare Future Use
2 RXD Received data (RS-232
input)
3 TXD Transmit data (RS -232
Page 32
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output)

4 GND

5 Vin DC Power Input

6 CME Command Mode Enable

7 CTS Clear to send (RS-232
output)

8 GND Signal Ground

All data signals (RXD, TXD, CTS) and the CME in
the SolidLink radio modem are RS -232 levels they
must be in the -12 to +12 VDC range.

The SolidLink radio modem data port provides a
DCE interface to be connected to a DTE in the user
equipment side. If the SolidLink radio modem is
connected to other DCE equipment the proper null
modem cable must be used.

Refer to the Data Mode, Command Mode, and
Command Protocol sections for more detail.

4.3 Data Interface

The Data interface is physically provided through the
circular power — data connector. All signaling is as
per RS-232. The data port configuration is set
through the SolidLink Network Manager, refer to the
Using the Router Software section.

1. The baud rate is selectable from 110 baud up to
57,600 baud,

2. Parity can be None, Odd or Even
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3. Stop bits can be 1 or 2
4. Both 7 or 8 data bits are supported.

Each SolidLink radio modem is provided with a short
power-data cable; however if needed, the following
cable can be used to connect SolidLink with external
devices through a DB-9 data connector.

D 3 o= = 2 RxD
Rl 2 - Lot 3 T«D
CTS 8 - ot T CTS
OTR 4 — = ——m § CME
GHND 5 & GND

0BS5S Female SolidLink EM3
Connector Connector

The radio, and data interface operate in two
separate modes: data and command. These modes
are discussed in SolidLink Theory of Operation.

4.3.1 Data Mode

When in Data Mode, the SolidLink radio modem
transfers data between the RF interface and the
serial port. The radio normally asserts Clear to Send
(CTS) by driving it to +12V. This indicates to the
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Remote Terminal Unit (RTU) that the radio will
accept data. The radio includes a 4096 Kbyte serial
data buffer, however at times, because of network
congestion or RF interference, the buffer may fill. At
that time, the radio will drop CTS, and the RTU must
stop sending serial data. Once CTS is reasserted,
the RTU can resume data flow.

woae [TTTITITITITT INERRREN]
—

o

4.3.2 Command Mode

When in command mode, the SolidLink radio
accepts commands allowing the user’s application
to:

1. Create and terminate a connection between two
radios

2. Obtain ID and version information about the
radio

3. Obtain diagnostic information about the radio
and network

4. Leave command mode and enter data mode.

When the SolidLink radio is in data mode, and CME
is driven low, it expects the next serial port data to
be an “ATEC” command, putting the radio into
command mode. It will respond with “OK”. The
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controlling device must then de-assert CME. The
radio will remain in command mode until it receives
an “ATQ” command. The CME line is normally
connected to the DTR signal in the controlling
device, and must be driven.

T

oata [[] [&EC [Ama ] L]
o
Rx Data oK oK

4.3.3 Command Protocol

All commands are issued by the controlling device
as ASCII strings starting with the ASCII characters
“AT". This is immediately followed by the command
type and then any qualifying arguments. The
command arguments may be variable in length. The
entire command string must be terminated with a
carriage return (Oxd), denoted here by <CR>

The radio will respond with an ACK if the command
is accepted and with a NAK if the command is
rejected. ACK consists of the ASCII string
“OK<CR>". If the command returns a value, it will
arrive after the ACK and will also be terminated by a
carriage return. NAK consists of the ASCII string “
nn<CR>" where nn is a one or two digit error code.

The commands, their arguments and returns are
described in detail in the Commands section.
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4.4 Mounting Options

The SolidLink radio modem is designed to be
installed in a variety of ways according to the
customer and project needs. Since the SolidLink
radio is weather proof the unit can be installed either
in the typical configuration next to the user DTE
equipment or as close as possible to the RF
antenna.

Each SolidLink radio includes two slideable stainless
steel mounting nuts, which are captive in the
channel on the bottom of the radio chassis. They
can slide along the channel to adjust the spacing to
suit the customer. These nuts accept 1/4-20
threaded bolts and are used to attach the SolidLink
radio to a variety of optional mounting hardware.
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Seimac Limited provides several mounting options,
sold separately:

1. DIN Rail;
2. Pole; and
3. 19" rack shelf.

4.4.1 DIN Rail Mounting Option

The SolidLink radio can be installed on a DIN rail
inside a NEMA box or other type of enclosure. The
DIN rail mounting kit includes a universal mounting
plate with a pair of DIN rail mounting clips. The
SolidLink radio is bolted to the universal mounting
bracket with a pair of 8-32 bolts (provided) that
attach to the captive mounting nuts. The whole
assembly is then clipped onto the DIN rail, either
vertically or horizontally (as shown below).

The following graphic shows a SolidLink mounted
inside a NEMA box with a flex antenna, that antenna
can be removed and the SolidLink unit can be

installed with the proper external antenna.
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4.4.2 Tower and Pole Mounting
Option

Similar to DIM rail installations, the SolidLink radio
modem can be installed in towers or poles next to
the RF antenna to reduce the RF cable losses. The
tower brackets are sold separately. Assembly
instructions are provided.

The tower brackets use the same universal adapter
that is provided with the DIN rail mounting option.
Instead of DIN clips, the pole adapter uses a U
shaped pole clamp, as illustrated below. The radio
can be mounted horizontally or vertically (refer
below).
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4.4.3 19" Rack Mounting Options

To support situations where it is convenient to mount
the SolidLink radio in a 19” rack mount enclosure,
Seimac provides a 19” rack mount option (sold
separately). This consists of a sturdy 10" deep shelf
pre-drilled to allow the SolidLink radio to be attached
with 8-32 bolts, in several orientations.

4.5 Lightning Protection

Always install the SolidLink radio modem with the
proper lighting arrester for 2.4GHz, even for short
RF cable lengths. Seimac Limited provides the

Polyphaser LCU 2.4 surge protector as an option.
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The LCU2.4 is provided with an N-Male connector
on the antenna side and an N-Female connector on
the radio side. It has an insertion loss of less than
0.2dB, which is negligible. Full details are provided
on the SolidLink web site www.solidlinkradio.com.

Note: The SolidLink product warranty does not
cover damage caused by lightning.

4.6 Antenna Selection

When operated under FCC or Industry Canada
regulations, antennas and RF cables used as part of
the installation must be purchased from Seimac
Limited. All of the antennas provided by Seimac
Limited are FCC and Industry Canada approved for
use with SolidLink.

Type Gain (dBi) | Seimac |Manufactur| Connector
Model er Model
Oomni 2.2 SLA-2400- Maxrad TNC-M
20 MHWS2400
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C
Omni 5.5 SLA-2400- Maxrad N-F
50 MMO24005
PTCRP
Directional 12 SLA-2400- | Hyperlink N-F
12D HG2412
Directional 16 SLA-2400- Pacific N-F
16D Wireless
PAWVA24-
16
High Gain 18 SLA-2400- Conifer N-F
18D 18T-2400
High Gain 24 SLA-2400- Conifer N-F
24D 26T-2400

Seimac provides a wide variety of antennas to suit
different applications. They range from a 2.2 dBi
omni that mounts directly onto the SolidLink radio to
a 24 dBi parabolic. Details and data sheets on the
various antennas can be found on the SolidLink web
site www.solildlinkradio.com and within the following

sections:

1. Omni Directional Antennas

2. Directional Antennas

3. High Gain Directional Antennas
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4.6.1 Omni Directional Antennas

Seimac provides two omni directional antennas:

1. The Maxrad 2.2dBi MHWS2400C TNC female
antenna is offered to perform in lab tests. This
is a basic “rubber duck” antenna that mounts
directly to the TNC Female connector on the
SolidLink radio. This antenna is also suitable for
in-plant applications where short distances
between antennas allow low radiated power and
low antenna height.

2. The Maxrad 5.5 dBi MMO24005PTCRP N
female connector antenna is intended to be
used with SolidLink radio modems when the
radio is the Master unit in point-to-multipoint
applications. The antenna is intended to be
mounted to a mast. The technician must take in
consideration that since this is an antenna that
radiates power in all directions it is also
susceptible to receive undesired RF signals from
all directions.

4.6.2 Directional Antennas

The reason for using directional antennas is to
create links between two units with the reduced
signal degradation and interference with other RF
sources. It can also reduce transmitter power levels
which can be important when operating on batteries.
Another benefit is reduced interference with other
receivers, not in the “line of sight”.
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SolidLink networks can use directional antennas for
Remote site locations linked to the Master unit or to
Remote units linked to the Repeater. Also,
directional antennas can be used to link a Master
radio with a Repeater radio. Directional antennas
can be used to make directional link configurations
more efficient and to reduce the impact of undesired
RF signals, both received and transmitted.

The use of directional antennas may require that
output power be reduced to maintain the EIRP within
regulations. Please refer to the Installation section.

Seimac Limited provides two directional antennas,
the Hyperlink 12 dBi Yagi HG2412Y with an N
female connector and the Pacific Wireless 16 dBi
Yagi PAWVA24-16 with an N female connector.
Both of these antennas are intended to be pole
mounted, and are provided with mounting hardware.

4.6.3 High Gain Directional Antennas

High gain antennas provide a very reliable RF link
between two point-to-point SolidLink radio modems.
Seimac recommends that high gain directional
antennas be used when SolidLink radio modems are
used to link two sites in a point-to-point
configuration. The use of high directional antennas
reduces the impact of undesired interference with a
SolidLink network, while also helps to keep a
cleaner RF environment.

Seimac Limited provides two high gain directional
antennas: the Conifer 18 dBi 18T-2400 with an N
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female connector and the Conifer 24 dBi 26T-2400
with an N Female

4.7 Installation

SolidLink complies fully with FCC part 15 rules, and
with Industry Canada RSS-210. If SolidLink is being
used under FCC or Industry Canada jurisdiction, it
must be installed by a professional installer. Only
antennas certified for use may be used, these are
provided by Seimac Limited.

Seimac Limited offers technical training courses to
properly install and configure SolidLink radio
modems according to the FCC and Industry Canada
regulations.

In Canada, the installer of this radio equipment must
ensure that the antenna is located or pointed such
that it does not emit RF field in excess of Health
Canada limits for the general population; consult
Safety Code 6, obtainable from Health Canada’s
web site www.hc-sc.gc.ca/rpb.

This device complies with FCC RF radiation
exposure limits; however it is important that the
device be installed such that human exposure to
harmful RF radiation is minimized. In order to
comply with RF exposure limits, the following
minimum separation distances between the
transmitter antenna and all persons should be
maintained:

Omnidirectional 20cm
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Directional (Yagi) 2m
High Gain Directional 2m
(Parabolic)

The directional and high gain directional antennas
are for fixed outdoor installations only.

4.7.1 Mounting Considerations

The SolidLink radio includes a weather tight
package that can be installed in an outdoor
environment. Radio mounting options are discussed
in the Mounting Options section. The unit will
operate over the temperature range -40°C to +75°C,
SO care must be taken to ensure that ambient
temperatures do not exceed these maximums.

If RF performance is an issue, it often is, that the
antennas should be mounted as high as possible to
reduce path loss. Refer to the Estimating RF
Performance section for more information. If RF
performance is not an issue, for example if a
network is setup within a small area so that link
distances are short, then antenna height is less
important.

At 2.4 GHz, cable loss can be significant. Seimac
provides WBC-400 and WBC-600 coaxial cable with
losses of 7 dB and 4.4 dB per 100 ft. In order to
minimize cable loss, the SolidLink radio can be
located close to the antenna. All antennas and the
SolidLink radio are available with pole mounting
hardware.
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If the SolidLink radio is mounted on the pole, then
the data and power cable must be run up the pole to
the radio. Seimac provides optional power-data
cables of up to 15m in length. This is the longest
practical cable run for the RS-232C signaling
protocol at 57,600 baud.

4.7.2 Estimating RF Performance

The performance of a radio link between two
devices is a function of the system gain and path
loss. The difference between the two is the link
margin. Seimac recommends that the system be
designed for a link margin of at least 10dB.

System gain includes the transmitter power, the gain
and loss through the transmitter antenna and cables,
the gain and loss through the receiver antenna and
cables, and the receiver sensitivity. In general

Gs=Po+Gra+Gm + K

For example, a typical SolidLink installation might
include:

Output power 30 dBm (1W maximum)
Transmitter cable loss 2dB
Transmitter antenna gain 5.5 dB
Receiver antenna gain 5.5 dB

Receiver cable loss 2dB

o g M w NP

Receiver sensitivity -104dB
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Gs=30-2+55+55-2+ 104 = 141dB.

Calculating the path loss is more complicated and
much less precise. Itis very much a function of the
distance between the transmitter and receiver, the
height of each, the atmospheric conditions and the
terrain. In general, path loss decreases as distance
decreases and as antenna height increases. The
plane earth model can be used as first
approximation of the propagation loss:

Lpe = 10*LOgyo [D*/ (HT?*HR?)]
where:

D = distance between the transmitter and
receiver in meters

HT = height of the transmit antenna above
ground in meters

RT = height of the receive antenna above
ground in meters

Based on this formula, the following table illustrates
expected propagation losses for a variety of distance
and height combinations. It also includes a link
margin calculation based on the system gain
calculation above. Link margins below 10 are not
recommended.

© 2003 by Seimac Limited, All Rights Reserved

Ht (m) Hr (m) D (km) | Lpe (dB)| Gs (dB) | Lm (dB)
2 2 1 107.96 141 33.04
5 5 1 92.04 1416 48.9
15 15 1 72.96 141 68.04
Page 48




SolidLink SS2400S Operators Manual

18 September 2003 Version DRAFT
135.92 141 5.08
5 5 5 120.00 141 21.00
15 15 5 100.92 141 40.08
15 155.00 141 -14.00
5 5 15 139.08 141 1.92
15 15 15 120.00 141 21.00
25 163.88 141 -22.88
25 147.96 141 -6.96
15 15 25 128.87 141 12.13

4.7.3 Power and Grounding

The SolidLink radio requires a DC supply voltage of
between 10 and 26 Volts. The installer must
consider the cable loss when determining the supply
voltage. Assuming an active radio, the resistive
voltage drop on the power and ground leads across
a 15m cable will be approximately 1V at the low end
of the power range. This means that the power
supply must supply at least 12V across the cable in
order to provide the minimum 10V to the SolidLink
radio DC power input.

The RF shield ground and DC power ground are
coupled in the SolidLink radio. Seimac recommends
that the RF cable shield be grounded externally
through a lightning protector located in close
proximity to the radio.
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Because of the durable marine epoxy paint that is
covers the SolidLink case; a reliable ground cannot
be made by physically connecting the SolidLink
radio to a grounded object, such as a tower or mast.
The ground should be made through the RF cable
shield.

4.7.4 Surge Protection

Seimac Limited strongly recommends that the
SolidLink radios and antennas be installed with
lightning protection. Seimac provides the optional
Polyphaser LCU2.4 for this purpose.

Where the SolidLink radio is located very close to
the antenna, with a short co-axial cable, then one
LCU2.4 should be installed between the transmitter
and the antenna. The installer must be careful to
ground the surge protector. If the SolidLink radio is
located at the base of a tower or in an equipment
enclosure, then Seimac recommends that surge
protectors be installed at the antenna and at the
transmitter, again they must both be carefully
grounded.

4.7.5 Antenna and Cable Connection

Under FCC and Industry Canada regulations, the
maximum allowed transmitted power, out of the
SolidLink radio (PR) is 30dBm, or 1 Watt. The
maximum antenna gain (GA) is 6dB. Assuming no
cable loss, the maximum effective radiated power
(ERP) is:

Page 50
© 2003 by Seimac Limited, All Rights Reserved



SolidLink SS2400S Operators Manual
18 September 2003 Version DRAFT

ERP = PR + GA =36dBm

Seimac Limited provides a variety of antennas and
cables:

Type Gain (dBi) | Seimac | Manufacturer |Connector
Model Model
Oomni 2.2 SLA- Maxrad TNC-M
2400-20 | MHWS2400C
Omni 55 SLA- Maxrad N-F
2400-50 | MMO24005PT
CRP
Yagi 12 SLA- Hyperlink N-F
2400-12D HG2412
Yagi 16 SLA- Pacific N-F
2400-16D Wireless
PAWVA24-16
Parabolic 18 SLA- Conifer 18T- N-F
2400-18D 2400
Parabolic 24 SLA- Conifer 26T- N-F
2400-24D 2400

Cable Loss (dB)

Cable Type WBC 400 WBC 600

Loss (dB/100m) 22.97 14.44

Cable Length (m)

1 0.23 0.14
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5 1.15 0.72
10 2.30 1.44
15 3.44 2.17

To reduce potential radio interference to other users,
the antenna type and its gain should be so chosen
that the equivalent isotropically radiated power is not
more than that required for successful
communication.

From an FCC and Industry Canada regulatory
perspective, there are two types of links, with slightly
different rules regarding maximum allowable ERP.

A point-to-multipoint link is a situation where a
radio communicates with more than one other radio,
and therefore cannot radiate in a single direction.
Examples include a Master radio that communicates
with several Remote radios that were geographically
dispersed, and any Repeater. Omni directional
antennas must be used.

A point-to-point link is a situation where a radio
communicates with one other and therefore can
radiate in a single direction. Examples are a Master
that communicates with a single Remote or any
Remote radio. Directional antennas can be used to
improve performance and reduce unintentional
interference with other ISM band equipment.

For information on configuring these links refer to
the Point-to-Multipoint and Point-to-Point sections.
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4.7.6 Point-to-Multipoint

When configuring a point-to-point link, the maximum
ERP is calculated as follows:

ERP=Pgr+ G —Lc=36dBm
Consider the following network:

g
// R
-~
e
Rz
Master

The links from the Master radio to the Remote radios
are point-to-multipoint links because the Master
communicates with several spatially diverse
locations. The Master must use an omni directional
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antenna. The Remote obey point-to-point rules. All
Repeaters obey point-to-multipoint rules.

Seimac provides two omni directional antennas, one
with a 2.2 dB gain and the other with 5.5 dB gain.
With full transmit power, and the highest gain
antenna, and assuming the best case cable loss
(0dB), the ERP is:

ERP=P; + Gy —Lc=30dB + 5.5dB —
0dB = 35.5dB

This is less than the maximum allowable ERP;
therefore the installer is free to set the SolidLink
output power to any value between 100mW and 1W.
Refer to the Setting the RF Output Power section for
details on this and on cable length.

4.7.7 Point-to-Point

When configuring a point-to-point link, the maximum
allowable ERP can be increased above 36dBm as
follows:

For every 3dB increase in antenna gain above 6dB,
the transmitter output power must be decreased by
1dB. The antenna gain calculation includes cable
losses, so is a function of complete installation.

For example, with an antenna gain of 12dBi, the
transmitter power output could be set to:

Pg = 30dBm — (12dBi-6dBi)/3 = 28dBm
ERP = 27.8dBm + 12dBi = 39.8dBm
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The following tables show the output power setting
that must be used for each cable length, when used
with each antenna. There are four directional
antennas, two cable types, and four cable lengths.

Maximum Output Power Settings (mW)

Antenna Type HG2412Y
Antenna Gain (dB) 12
Cable Type WBC 400 WBC 600

Cable Length (m)
1 600 600
5 600 600
10 700 700
15 800 700

Maximum Output Power Settings (mW)

Antenna Type PAWVA24-16
Antenna Gain (dB) 16
Cable Type WBC 400 WBC 600

Cable Length (m)
1 400 400
5 500 400
10 500 500
15 600 500
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Maximum Output Power Settings (mW)

Antenna Type 18T-2400
Antenna Gain (dB) 18
Cable Type WBC 400 WBC 600

Cable Length (m)
1 400 400
5 400 400
10 400 400
15 500 400

Maximum Output Power Settings (mW)

Antenna Type 26T-2400
Antenna Gain (dB) 24
Cable Type WBC 400 WBC 600

Cable Length (m)
1 200 200
5 200 200
10 200 200
15 300 200
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4.7.8 Setting the RF Output Power

The RF output power is set through the SolidLink
Network Manager (refer to the section on Network
Properties), when designing the network and
configuring the radio. Available options (in mW) and

the equivalent output power in dB are:

Power (mW) Power (dBm)
100 20.0
200 23.0
300 24.8
400 26.0
500 27.0
600 27.8
700 28.5
800 29.0
900 29.5
1000 30.0
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5 SolidLink Network
Manager

The SolidLink radio and the SolidLink Network
Manager (SLNM) software, together, provide the
complete data communication system. SLNM is a
Windows application program that runs on a PC
under Windows 98, NT, 2000 or XP where it
supports the design and maintenance of SolidLink
networks. It allows its user to:

1. design SolidLink radio networks using a
graphical network design tool;
2. configure individual radios to deploy networks;

3. watch traffic flowing between a user’s
application and the network; and

4. obtain network and radio diagnostics online.
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RTU

Application SLNM

Data Host PC

While an application computer can connect directly
to the Master radio, the SLNM can transparently sit
between the two and allow the user to effectively
monitor the network and diagnose problems.

5.1 Installation

Installation of SLNM is made easy through an
automatic install process upon inserting the SLNM
CD. This one time procedure includes the SLNM
user interface, Router software, and Terminal
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Window. If for any reason automatic installation
does not begin instructions have been provided
below.

Note: In order to install SLNM on a system
having a Windows NT operating system, or
later version of Windows, you must have
'Administrator’ privileges for that installation
computer. If you do not have Administrator
privileges, contact your System Administrator
and have them perform the installation.

Once installed the SLNM, Router, and Terminal
Window are available.

Note: the Terminal Window will run on a
continuous basis unless terminated by you.

= Double-click the "setup.exe" file or click the Windows
"Start" button, then select "Run".

= Click the "Browse..." button and browse to the "setup.exe"
file on the CD-ROM and select it.

You will be returned to the "Run" window.
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Run E|®

- Type the name of a program, folder, document, ar
g Internet resource, and Windows will open it for you.

Open: D:'n,.'?eb.lp.exe W

l OK H Cancel ][ Browse...

From this “Run” dialog window:
= Click "OK" to begin the installation program.

When the installation program starts, you will be presented
with several dialogs that require your input or response.

= Follow the instructions presented, making the selections
you desire, clicking the "Next" button after you have
completed each dialog.

= Once you have provided all the required information, click
the "Install" button to complete the installation of SLNM.

The installation will create a program group in the Windows
Start menu and a shortcut on the Windows desktop to allow
easy access to SLNM.

The first time that SLNM is run, the user is prompted
to create the default network database. This
database file contains up to 64 different network
designs.
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5.2 Components

The SolidLink Network Manager includes several
components that work together to provide the
complete application:

/
L /" NetworkManagerPC
Network Terminal
Manager Window
Applcation ;N

Router r—f\é
Log File
L W o

The primary elements are:

1. Network Manager;
2. Terminal Window; and
3. Router.

5.2.1 Network Manager

The Network Manager is the user’s primary interface
with the SLNM. It is written as a conventional
windows application, with familiar menus, toolbars
and window size controls. When the user selects
“SolidLink Network Manager” from the "Program"
menu; it is the Network Manager that launches.
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ink Network Manager
File Edt Tools Router Radic Metwork View Window Help

NEH & e ada Tk +—]|

| reay | | Documentation.db | B2

From here the user can open existing networks,
create new networks, and configure networks and
radios. Standard and frequently used functions are
available as toolbar elements. The Network
Manager includes familiar “right -click” menus on the
graphical components to provide quick access to
commonly used menu functions.
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The user controls the router and the terminal window
from the Network Manager, both are available
through menu controls. This user manual is
available as online help, accessible through the Help
menu or the "?" tool.

The user works with networks through a graphical
interface. lcons representing Master, Remote or
Repeater radios are dropped onto the canvas, and
interconnected with an interconnection tool. The
radio icons can be moved anywhere; their physical
location on the canvas has no bearing on the
network topology. What matters is how they are
interconnected. Once a network is operational, the
SLNM can remain connected to the Master radio. In
this situation, the user can obtain diagnostics from a
radio by simply selecting the radio on the canvas
and then selecting diagnostics from the radio menu.
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Note: When the user stops the network
manager by selecting "File" | "Exit", the
Terminal Window and Router remain active.

5.2.2 Router

The Router is installed as part of the SolidLink
Network Manager and starts when the user logs in.
It can also be started and/or restarted manually from
the Windows Start menu.

Note: The Router has been designed as a
stand-alone application in the case that a user
requires only this application to be running at
any given time.

As its name suggests, the Router passes
information between the SolidLink network, the Data
Host, and the Network Manager and Terminal
Window.

Router - SolidLink Nebwork Manag; o I o] |

File Properties Help

RaDI0 COM zet to COM1.
DATAHOST COM set to COMZ.

Routing available data...

Normally, the Router is placed in the "Startup"
section of the "Program” menu, so that it starts
automatically when the user logs in. When active,

Page 65
© 2003 by Seimac Limited, All Rights Reserved



SolidLink SS2400S Operators Manual
18 September 2003 Version DRAFT

the Router icon is located in the system tray (by the
system clock usually at the bottom right of the
screen). Double-clicking on the icon opens the
Router interface shown above.

The Master radio and the user’s application (if
connected) must be connected to different COM
ports, which are user selectable through the
"Properties’ menu. Both ports share the same
configuration, so that the Network Manager PC can
be easily removed and the Data Host connected
directly to the Master SolidLink radio.

The Router can auto-baud in situations where the
user does not know the radio baud rate. This
feature is available through the Network Manager’s
"Router" menu. When auto-baud is selected, the
Router will determine which baud rate is correct, by
sequentially stepping through all available choices
and will set the port characteristics accordingly.

The Router also includes a data logging feature
which allows the user to capture to file the serial
traffic that flows in and out of the Master radio. The
user can set the default logging directory and can
limit the amount of disk space consumed the log
files.

The default communications settings, which are
used when the Router is run the first time, are:
1. Data Host COM Port = NONE;

2. Radio COM Port = NONE;

3. Port settings 57600, 8, N, 1, hardware flow
control;
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4. Logging is disabled;
5. No selected log file directory; and
6. Default log directory size = 10Mbytes.

Note: The Network Manager must be explicitly
connected to the Router in order to communicate
with the SolidLink network or to control and
configure the Router itself.

5.2.3 Terminal Window

The Terminal Window is, like the Router, installed as
part of the Network Manager application. Unlike the
Router, the Terminal Window is started explicitly
from the Network Manager. Its purpose is to
displays all serial traffic that flows in to and out of the
connected Master radio. The Terminal Window is
designed for use during application system testing
for monitoring traffic between the network and
application. It also provides a command window
whereby the user can enter data or AT commands
directly.
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Terminal Window - SolidLink Network Manager

Legend
Blue text = outgoing data to netwark.
Fed text = incaming data from network

‘ Send

Data that is destined for the network is shown in
blue, incoming data is shown in red. Printable ASCII
characters are displayed directly. Non printable
characters are shown in their hexadecimal
representation and enclosed in a pair of curly braces
{}. For example, the carriage return character is
displayed as {0xd}.

To send commands or data manually, the user types
data into the white data entry pane and then clicks
the "Send" button. Data is not removed from the
data entry pane when sent, so the same data can be
sent repeatedly by repeated clicks of the "Send"
button.
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5.2.4 Network Database

The Network Manager stores networks in the
Network Database. Through the File menu, the user
can create a new network database file, select a
database or set the default. Up to 64 networks can
be stored in one Network Database.

5.2.5 Log File

The SLNM Router allows the user to log serial traffic
to a log file as demonstrated by the following
example:

[07-07-2003_16. 34. 16]
>>ATEC{ 0x0d}
[07-07-2003_16. 34. 16]

<<OK{ 0x0d}
[07-07-2003_16. 34. 16]
>>ATDMD2000001{ 0x0d}
[07-07-2003_16. 34. 16]

<<OK{ 0x0d} =0000000000{ 0x0d}
[07-07-2003_16. 34. 16]

>>ATQ 0x0d}

[ 07-07-2003_16. 34. 16]
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<<OK{ 0x0d}
[07-07-2003_16. 34. 22]
>>ATEC{ 0x0d}

[ 07-07-2003_16. 34. 22]
<<OK{ 0x0d}

[ 07-07-2003_16. 34. 22]
>>ATDML6000001{ 0x0d}
[07-07-2003_16. 34. 22]

<<CK{ 0x0d} =0000000000, 0000000000, 0000000000, 0000000000, 0000
000000, 0000000000, 0000000000, 0000000000, 0000000000, 00000000
00, 0000000000, 0000000000, 0000000000, 0000000000{ 0x0d}

[ 07-07-2003_16. 34. 22]
>>ATQ 0x0d}
[ 07-07-2003_16. 34. 22]

<<CK{ 0x0d}

Each entry in the log file is composed of the
following three components:

= time stamp;

= data direction symbol; and

= data.

The time stamp is formatted as follows:

[ M dd- yyyy_hh. nm ss]
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where mm-dd-yyyy is the date in month-day-year
format, and hh.mm.ss is the 24 hour system time
when the data was added to the log file in
hours.minutes.seconds. This is the system time of
the PC running the Router application. A time stamp
is added to the file whenever there is a change in
data direction. The example above shows
commands being issued to the network, and then
command responses being received from the
network. The data direction is indicated by the data
direction symbol.

The data direction symbol indicates the source of
the data relative to the Router. Specifically, the
characters indicate:

>> outgoing data sent through the Router to the
radio network; and

<< incoming data sent through the Router from the
radio network.

The last component of each log file entry is the data.
If the data sent or received is, or contains, printable
ASCII characters, the data is recorded in the log file
as those characters. If the data sent or received is,
or contains, non-printable ASCII characters, then a
curly brace { } bound hexadecimal representation of
the character value is recorded in the log file. From
above, the line:

>>ATDML6000001{ Ox0d}

should be interpreted as follows:
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>> data direction symbol

ATDML6000001 printable ASCII characters

{0x0d} non-printable ASCII character (in this case a
carriage return character)

5.3 Menu Reference

This section of the manual describes each of the
menu items available in the Network Manager and
Router applications. Whenever a menu item is not
available, it will be de-selected and displayed in light
gray (instead of black). For example, if there is no
open network, then the Save Network menu item will
be unavailable and displayed in light gray. Also, if
the Network Manager is not connected to the router,
all of the menu items that involve the router or
communicating with the network will be unavailable.

5.3.1 Network Manager

The Network Manager provides the primary user
access to the SLNM, through the following menus:
File

Edit

Tools

Router

Radio

o~ DR
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Network
View
Window
Help

© ®©® N ©

5.3.1.1 Menu ltems

File

The File menu contains commands associated with
managing networks and network databases.

Menu

Description

New Network

Create a new SolidLink network.

Open Network

Open an existing SolidLink network.

Close Network

Close the currently selected network

and save to the selected Network
Database.

Save Network

Save the currently selected network to
the selected Network Database.

Select Network
Database

Select a Network Database to use as
the repository for SolidLink networks.

Create New Network
Database

Create a new and empty Network
Database.

Set Default Network
Database

Establish which Network Database to
use as the default when the SolidLink
Network Manager starts.

Delete Network

Delete a network from a Network
Database.
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Print Print the currently active window.

Exit Close SLNM, leaving the Terminal
Window and Router as they were.

Edit

The Edit menu contains a standard set of Windows
edit functionality.

Menu Description

Undo Undo the last edit command, insert or
delete.

Redo Redo the last edit command, insert,
delete, or undo.

Cut Cut the selected item to the windows
clipboard.

Copy Copy the selected item to the windows
clipboard.

Paste Paste the windows clipboard onto the

screen at the current cursor.

Delete Delete the currently selected item, or
text past the cursor.

Tools

The Tools menu contains the network design and
radio interaction tools. It gives access to network
design functionality through Master, Repeater, and
Remote radios, as well as the connector and text
tools.
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Menu

Description

Master Radio

Select a Master radio to be placed on
the network design pane. The radio is
placed by left-clicking on the design
pane.

Repeater Radio

Select a Repeater radio to be placed on
the network design pane. The radio is
placed by left-clicking on the design
pane.

Remote Radio

Select a Remote radio to be placed on
the network design pane. The radio is
placed by left-clicking on the design
pane.

Straight Connector

Select a straight connector to be placed
on the network design pane. Two
radios are interconnected by left-clicking

on the first radio and then dragging to
the second.

Text Tool

Select a text tool for placing a free-form
text blocks on the design pane. Left-
click on the design pane to place a text
block.

Selection Tool

Select the selection tool, used to select

and move radio icons on the design
pane.

Put Radio in Command
Mode

Causes the CME line to be pulsed and
the ATEC command string to be sent to
the radio, putting it into command mode.

The Network Manager must be
connected to the Router.

Terminal Window

Opens the Terminal Window.
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Router

The Router menu provides the user with a means to
control the SLNM Router.

Menu

Description

Connect to Router

Establishes a connection between the
Network Manager and the Router

Enable Logging to File

Sends a message to the Router,
requesting that it start logging serial
data. The log file directory is set-up

through the Properties menu of the
Router

View Router COM
Settings

Displays the current Router COM port
configuration.

Manually Configure
Router COM Settings

Provides a dialog box that allows the
user to setup the COM port settings
used by the Router to communicate with
the Master and the Data Host

Auto Configure Router
COM Settings

Requests that the Router automatically
determine the connected SolidLink radio
communication settings and set the
COM port to match.

Radio

The Radio menu contains menu items enabling
access to radio properties, configuration,
diagnostics, and the ability to view a radio’s route
table. They all require that a network be open and
that the user select a single radio.
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Menu

Description

View Route Table

Displays the routing table for the
selected radio.

View Last Diagnostics

Display the most recent set of

diagnostics collected for the selected
radio.

Diagnostics->

Provides a sub-menu that allows the
user to pick a specific diagnostic for the
selected radio. The router submits a
diagnostic request to the SolidLink
network, through the Master radio, and
the results are displayed.

Configure

Downloads the configuration for the
currently selected radio. A radio must
be connected to a COM port and the
router properly configured.

Radio Firmware->

Provides the user with a sub-menu that
allows a firmware update to be
download into the radio.

Properties

Provides a dialog box that lets the user

set the radio properties of the selected
radio.
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Network

The Network menu provides access to the currently
selected network’s properties, verify a network to
determine if its information and topology are valid,
and view the network’s route table.

Menu

Description

View Route Table

Displays the routing table for the entire
network.

Verify Network Design

Tests the network against a set of
design rules to ensure that the

configuration and topology are
consistent.

Properties

Provides a dialog box that lets the user
set the network properties.

View

The View menu provides the user with functions that
help to organize and view the network diagrams
displayed in the network pane.

Menu Description

Toolbar When checked displays the toolbar
below the menu bar.

Gridlines When checked displays gridlines on the
network pane.

Snap to Grid When checked forces the radio objects
to snap to the gridlines.

Zoom In Increases the network pane zoom by
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10%.

Zoom Out Decreases the network pane zoom by
10%.

Zoom Window Opens a zoom window (refer to the
graphic below).

2 oo stk Hanage: e 1 msoe el (0%

Db & BB &0= [Tk | ¥

] Doonanision? b B0

The Zoom window displays the entire network and
allows for panning, jumping to a specific location in
the network, and zooming - all from a single
interface. This is particularly useful for very large
network designs. Note however, that the toolbar
zoom buttons are disabled when the Zoom window
itself is open. Zooming is accomplished by
manipulating a slider at the top of the Zoom window:
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Window

The Window menu is common to most Windows-
based applications. It provides options for
organizing the view and toggling between currently
open networks.

Menu Description

Cascade Open all network windows and arrange
in a cascade.

Tile Horizontal Open all network windows and arrange
horizontally.

Tile Vertical Open all network windows and arrange
vertically.

Arrange Icons Arrange the closed network icons so

that they are adjacent, starting in the
lower left corner.

Help

The Help menu provides each access to information
about SolidLink and the SolidLink Network Manager.

Menu Description
Contents Opens the SolidLink users manual (this
document).
SolidLink Radio Opens www.solildlinkradio.com in the
Home Page default browse.
About Provides copyright, version, and Seimac
contact information.
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5.3.2 Router

Some router controls are provided in the Network
Manager Router menu. Others are accessed from
the router window directly. The router is normally
started when the user logs in. It is accessible as an
icon in the system tray, located near the system
clock. Double-click on the router icon to open its
window.

Router - SolidLink Network Manager A=
File Properties  Help

Fim,grga\mlahledaa LR ST L E e L R

Router - SofdLink Nebwork Manager

[BEsobp [[omcn Blro. [[EETercy sono &) ss7em

File
Menu Description
Enable Logging to Start logging serial data
File
Close Existing Socket|Close all internal connections to the
Connections Network Manager and the Terminal

Window. They should be re-initiated by
the Network Manager and by restarting
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the Terminal Window

Reinitialize Serial
Ports

Close and re-open the configured COM
ports

Exit

Exit the Router application

Properties

Menu

Description

COM Port Settings

Opens a dialog box that lets the user
configure the COM ports.

Set Log Directory
Size

Opens a dialog box that lets the user
establish the maximum size of the log file
directory, so that the SLNM cannot

inadvertently use up all available disk
space.

Set Path to LogFile
Directory

Opens a dialog box that lets the user set

the directory into which log files will be
created.

Help

Menu

Description

Contents

Opens the SolidLink users manual (this
document).

SolidLink Radio
Home Page

Opens www.solildlinkradio.com in the
default browse.

About

Provides copyright, version, and Seimac
contact information.
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54 HowTo

This section of the manual describes how to use the
SolidLink Network Manager to design networks,
configure and deploy radios, and test networks and
maintain them in the field.

5.4.1 Building a Network

Developing a network is done through the Network
Manager.

5.4.1.1 Working with the Network
Database

The SolidLink Network Manager can hold up to 64
separate networks in a network database. The
current network database is set through a dialog box
accessed through the “Select Network Database”
from the “File” menu. A user can have several
databases, although only one is open at a time.
Switching between databases during a single
session is accomplished by simply selecting another;
the user will be prompted to close all open networks.
The currently active database is displayed in the
status bar on the bottom of the Network Manager
window.

Existing networks are opened by selecting “Open”
from the “File” menu. The user selects from a list of
networks that exist in the currently open network
database. The “File” menu also includes elements
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that allow the user to save, close, and create new
networks.

Networks or segments of networks can be copied
from one database to another by first opening a
network, selecting the desired elements and then
copying them to the clipboard by selecting ‘Copy”
from the “Edit” menu. The user then opens the
destination network (either in the same or a different
database) and then pastes in the elements by
selecting “Paste” from the “Edit” menu.

5.4.1.2 Setting Network Properties

Each network has a set of associated network
properties. These are set or modified by selecting
“Properties” from the “Network” menu, which
causes the network properties dialog box to be
displayed. This dialog box is also automatically
displayed when a new network is created. There
are two pages in this box: basic and advanced.
These parameters are loaded into all radios when
they are configured.
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Network Properties (* Required Field)

Advanced Properties

* Network, [D: I‘I_ [range 0 - €3]
Metwark Mame: [Metwork 1
Metwork Type: |Pint to Multi-point =]
Protocal; |Standard ﬂ
CT5 Mode of Operation: |Hardware Handshaking ﬂ

* Time ta Sleep [seconds]: 0
* Time to Stay Awake [zeconds): an

Metwork Description:

(1] | Canhcel |

Network 1D This required field is unique for the
network (within the database), it
identifies the network the both within the
database and also in the field in case
multiple SolidLink networks are
operating in the same area.

Network Name An arbitrary name for the network.

Network Type This identifies whether the network is
configured to operate as point-to-point or
point-to-multipoint, as described in
Network Configurations.
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Protocol

CTS Mode of
Operation

Default Addressed
Radio

Time to Sleep

Time to Stay Awake

Network Description

Number of Non-
broadcast Message
Retries

Number of Times to
Repeat Broadcast
Messages

Only the standard protocol is currently
supported.

Only hardware handshaking is currently
supported.

This parameter identifies radio that the
Master will communicate with by default,
when it first powers up. It is useful in
two node point-to-point connections,
because it the virtual link is established
without having to issue an ATDT
command.

SolidLink provides a low power
capability whereby communications will
cycle off and on as defined by the Time
to Sleep and Time to Stay Awake
parameters. When the network turns on
after being asleep, it re-establishes
synchronization and then information
can flow. The maximum time to sleep is
TBD seconds. If this parameter is set to
zero, then the network will not sleep.

As described above, defines the awake
time if the network power is cycling, it
must be greater than zero.

An arbitrary description of the network.

This parameter defines the number of
times that a transmitting radio will resend
a packet, if the receiver detects an error

in the data. Broadcast messages are
treated differently.

Broadcast messages (addressed to
radio ID 0) are not acknowledged or
retried. They are always re-broadcast
the number of times defined by this
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parameter. Higher numbers increase
the probability of the message getting
through (in the presence of channel
noise), but decreases the available

bandwidth.
Timeout on Packet If a non-broadcast packet is
Retry retransmitted, the transmitting radio

walits a fixed timeout plus a random
timeout (to ensure two radios do not
continuously collide). This parameter is
the fixed timeout portion.

Time to Lose Lock on A radio is in network sync when it

Network continuously receives synchronization
packets, which are propagated through
the network from the Master nominally
every 4 seconds. This parameter
defines the length of time that a radio will
allow to pass, without receiving a valid
sync packet, before it declares that it has
lost sync (extinguishing the sync light)
and tries to re-acquire network sync.

5.4.1.3 Adding and Connecting Radios

Networks are built up by creating a graphical picture
of the network on the network canvas. The tools for
doing this are available in the “Tools” menu.

Select the Master Radio tool icon (*'¥), from the
application toolbar or “Master Radio” from the menu
and then click in the Network Diagram to place a
Master radio. Similarly, Repeater and Remote
radios can be placed. The physical position on the
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canvas does not affect the network operation or
configuration.

Select the Straight Connector tool ( \ ) or select
“Straight Connector” from the menu to create
network connections between radios. With the
connector tool selected, drag between two radios to
create a connection between.

1

B

2
-aP

A text tool is available to add arbitrary text blocks
any where on the canvas, for example to title the
network.

]

Do @ ol EBE ~ Tk £—wmap

1 2 ——— i
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5.4.1.4 Setting Radio Properties

In addition to the network properties described in
Setting Network Properties, each radio is configured
with a set of individual properties. Radio properties
are accessed in either of two ways. Either right click
on a radio and select “Radio Properties’ from the
pop-up menu or select a radio and then select
“Properties” from the “Radio” menu.

Radio Properties (* Required Field)
Basic Properties  Adwanced Properties

* Radio ID: |2— [range 2 - 1000]
R adio Mame: |
Radio Type: Im
Serial Port Baud Rate: Im
Serial Part Parity: lm

Serial Port Data Bits: a -
Serial Part Stop Bits: 1 -

RF Output in milliwatts [miw]: 1000 -
0K Cancel
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Radio Properties (* Required Field)
Basic Properties

* pstream Hop T able: 1 B
* Downstream Hop Tahble: [ &

0K Cancel

Radio ID The address of the radio, this must be
unique within the network. It is the
address used to dial a radio with the
ATD command.

Radio Name An arbitrary name for the radio.

Radio Type This parameter determines whether the
radio will operate as a Master, Repeater
or a Remote.
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Serial Port Baud Rate The serial port communication rate,
established from a drop down menu to
be between 110 and 57.6K. The baud
rate, and the other communication
parameters must be selected to be
compatible with the device that is
connected to the radio.

Serial Port Parity The serial port parity, either None, Odd
or Even.

Serial Port Data Bits The number of data bits used in serial
port communications, either 7 or 8.

Serial Port Stop Bits  The number of stop bits used in serial
port communications, either 1 or 2.

RF Output Power in  This parameter determines the transmit

milliwatts output power. Under FCC and IC
regulations, the radio output power must
be set according to the limits described
in point-to-point and point-to-multipoint.

Upstream Hop Table SolidLink provides five independent hop
tables for use in situations where
multiple radios will have overlapping
coverage. The upstream table is table
used to communicate with the next
upstream radio (towards the Master).

Downstream Hop As above, this table is used to

Table communicate with all directly connected
downstream nodes (away from the
Master).
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5.4.1.5 Verifying Network Integrity

There are a few rules that must be kept in mind
when designing a network. SLNM provides a design
rule check, accessible by selecting “Verify Network
Design” from the “Network” menu. A design rule
check is also performed when a network is saved.

1. A valid network must consist of at least two
radios, and if only two radios are present, one
must be a Master and the other must be a
Remote.

2. A network can consist of up t01000 radios
3. A valid network must have one Master radio.

4, The Master radio must be the most upstream
radio; it can have only downstream links to
Repeaters and/or Remotes and can have up to
999 links.

5. Remote radios can have only one link and that is
an upstream link to a Master or to a Repeater.

6. Repeaters must have one upstream link, to the
Master or another Repeater, and can have up to
997 downstream links to other Repeaters and/or
Remotes.

7. Connected radios must use the same hop table.
5.4.2 Deploy a Network

To deploy a network, the user must configure the
router to communicate with the radios over the PC
COM port, and then connect each radio in sequence
to the PC and download its configuration.
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5.4.2.1 Set up the Router

Normally, the router starts when the user logs in, it is
placed in the Program Startup menu. When

running, the Router Icon (-cfr)) will appear in the
Windows system tray, near the clock. Refer to the
Router section for detalils.

With the router running, select “Connect to Router”
from the “Router” menu, the Network Manager is
now connected to the Router. Also under the
“Router” menu, the user can view the COM port
settings, set them and have them automatically set
to match the radio. It is vital that the port settings
match the radio.

Auto-configuration steps through the various baud
rate settings, starting at the highest and works down
to 110 baud, until it finds the correct match. It also
searches for the correct start bits, stop bits, and
parity settings.

If the router has only one COM port, or will not be
connected to a data host, then the Data Host COM
port should be set to "None".

If the radios in the network are set to different baud
rates, then the user will have to adjust the Router
baud rate as appropriate prior to configuring each
radio.
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5.4.2.2 Configuring a Radio
Configuring a radio is a simple operation.

=  Open the appropriate network

= Connect the Network Manager to the router and
properly configure the Router serial port as
discussed in the Setting up the Router section.

= Connect the radio’s serial cable to the COM port
refer to the Data Interface section.

= Connect DC power to the radio and apply
power. At this point the radio power light should
be on.

= Select the specific network node to be
configured and configure the radio by either
right-clicking on the radio and selecting
“Configure” from the pop-up menu or selecting
“Configure” from the “Radio” menu.

= The Network Manager will now download the
configuration into the radio; this operation takes
between 10 seconds and 3 minutes, depending
on how much of the current configuration is at
57K baud. The user will be notified when the
operation is complete.

= If the configuration is successful, the radio will
reset and start-up with its new configuration.
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5.4.2.3 Loading Firmware Updates

Loading firmware is similar to loading a
configuration, except that it is not necessary that a
network be open. Seimac will distribute firmware
updates from time to time. They are provided in
“A90” format files which a specific hex
representation of the code to be loaded into the
SolidLink radio’s microprocessor.

There are two types of loads, each identified with a
specific menu selection. Normally, the user will
select the “Update Existing Firmware” option, as
this is used to over-write existing valid firmware. If
for some reason the radio firmware has become
corrupt, the user will select “Install Initial
Firmware”. The latter should only be done under
the advice of Seimac’s technical support
representative.

The process is straight-forward:

1. Connect the Network Manager to the router and
properly configure the Router serial port as
discussed in the Setting up the Router section.

2. Connect the radio’s serial cable to the COM port
as discussed in the Data Interface section.

3. Connect DC power to the radio and apply
power. At this point the radio power light should
be on.

4, Open any network and select any radio.

Select the “Update Existing Firmware” from
the “Radio” menu. The user will be presented
with a standard Windows file selection dialog
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box, from which the A90 firmware load file
should be selected.

6. The Network Manager will now download the
firmware into the radio; this operation takes
approximately 3 minutes at 57K baud. The user
will be notified when the operation is complete.

7. If the download is successful, the radio will reset
and start-up with its new firmware.

Normally, the user would then configure the radio as
detailed in the Configuring a Radio section.

5.4.3 Testing a Network

Once the network has been configured, it should be
then tested to see that the radios work and that the
connections are intact. This can be readily
accomplished in a lab setting, by connecting each a
2.2dBi rubber duck omni antenna to each radio and
setting the transmit power to 100mW. The following
sections assume that this is the situation, and that
each radio has DC power applied and serial cable
that can be connected to a PC COM port. The user
can:

1. Connect the SLNM to a SolidLink radio in order
to control or query the network or to monitor
data flow.

2. Obtain diagnostic information about any node in
the network.

3. Use the terminal window to monitor data and to
act as a data source.

Page 96
© 2003 by Seimac Limited, All Rights Reserved



SolidLink SS2400S Operators Manual
18 September 2003 Version DRAFT

4. Send commands to a radio in order to create
virtual links.

In general, each radio can be connected to a real
data source, such as would be used in the field, or
can be connected to a PC running SLNM or a
terminal window program such as Hyperterminal or
Procomm.

5.4.3.1 Connecting SLNM to a SolidLink
Radio

This operation is similar to configuring a radio:

= Open the appropriate network as described in
the Working with the Network Database section.

= Connect the Network Manager to the router and
properly configure the Router serial port as
discussed in the Setting up the Router section.

= Connect the radio’s serial cable to the COM
port; refer to the Data Interface section.

= Connect DC power to the radio and apply
power. At this point the radio power light should
be on.

The user can now use the SLNM to communicate
with the network. If connected to the Master radio,
the user can obtain diagnostic information, and issue
commands to make a virtual connection.
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5.4.3.2 Obtaining Diagnostic Information

Once the SLNM is connected to the network Master
Radio, as described in the Connecting SLNM to a
SolidLink Radio section, the user can obtain
diagnostics from each network node. This is a good
way to establish that all nodes and links are active.

1. Select node for which diagnostics is to be
requested.

2. Select “All Diagnostics” from the “Diagnostic”
sub-menu of the ‘Radio” menu, this is also
available on the pop-up menu accessed by right
clicking the network node icon.

3. The SLNM will send a diagnostic command to
the Master radio, which will in turn be forwarded
to the requested radio. This radio will return its
diagnostic information to the Master radio where
it will be sent out its serial port, captured by the
SLNM and presented to the user.

There is a wide variety of diagnostic information
available; it is best described in the Diagnostic
Commands section. At this stage, without data
traffic, the important event is just getting the
diagnostic data back, as it indicates that the node is
reachable. The following graphics show such data.
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Once the network is operational and some data
moved, then the same technique can be used to
obtain packet counts, and signal strength
information.

It is important to note that diagnostic information
must be requested through the Master node.

5.4.3.3 Sending Commands to a Radio

With the terminal window, the user can monitor the
flow of data in and out of the attached radio, can
send data to the radio and can issue commands.
The radio will be either in data or command mode as
described in the Operating Modes section.
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1. With the router active, the terminal window is
activated by selecting “Open Terminal
Window” from the “Tools’ menu. Terminal
window operation is described in the Terminal
Window section.

2. Putthe radio into command mode by selecting
“Put Radio in Command Mode” in from the
“Tools’ menu. The dialog associated with this
will be visible in the terminal window.

3. Enter the string “AT” followed by the "Enter" key
into the dialog area of the command window and
then press the “Send” button.

4. Watch the dialog evolve - the radio will respond
with the string "OK".

5. Pressing “Send” again will re-enter the
command, the contents of the dialog area are
not destroyed when they are sent.

6. Additional commands can be sent, refer to the
Commands and Diagnostic Commands sections
for a detailed description of the available
commands.

7. Enter the command ‘ATQ" to leave command
mode and return to data mode.
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5.4.3.4 Sending Data across the Network

This section shows how to easily send small
amounts of data across a network; it illustrates the
process of making a connection. The exercise
requires two PCs each running SLNM.
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Alternatively, the PC connected to the Remote could
run HyperTerminal or some other terminal emulator
that was properly connected to the radio COM port.

1. At the Master node, use SLNM to put the radio
into command mode as described in the
Sending Commands to a Radio section.

2. At the Remote node, start the router and open
the Terminal Window as described in the
Terminal Window section.

3. At the Master node, enter the command
ATDTnnnn<enter> into the dialog area of the
terminal window where nnnn is the four digit
decimal node number of the Remote. Each
node on the network graph is labeled with its ID.
For example, if the Remote node was ID 1, then
the command to establish a virtual connection is
ATDTO0O0O01<enter>.
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4. Press "Send" and observe the dialog, the
Master should respond with "OK". At this point,
a virtual connection has been created between
the serial port on the Master and the serial port
on Remote 1.

5. Return the Master to Data Mode by issuing the
command “ATQ<enter>". At this point, any data
that enters the Master serial port, is transmitted
out the serial port of Remote 1 and vice versa.

6. Type something into the dialog window of the
Master terminal window and press Send. The
information will appear at the Remote terminal
window. Similarly, anything entered into the
Remote terminal window dialog area will appear
at the Master’s terminal window.

7. Put the Master back into command mode, and
enter the command ATHO, followed by the
command ATQ. This causes the connection to
be terminated and the Master to be placed back
into data mode. Now, anything typed at the
Master and Remote will not appear at the other
node.

5.4.4 Monitoring an Operating
Network

Over the long term, one of the advantages of the
SLNM is that it can be used on-line with an
operational system. It can be used to obtain
diagnostics, log traffic, or watch traffic with the
terminal window.
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5.4.4.1 Using SLNM with a Data Host

The connection between an application running on a
data host and the SLNM is illustrated below:

- /" Network ManagerPC
DataHost 9
Network Terminal
Manager Window
Appication Network
Database ;ﬁ

Router f—\_//\d
Log File
L N o

One of the router’s functions is to transparently pass
data through between the application and the
network. The router forces the two COM ports (one
connected to the Data Host and the other to the
Master) to use the same communication parameters.
Thus, it is always possible to simply disconnect the
Data Host from the Master and insert the SLNM
between. The only change that must be made is to
insert a null modem between the Network Manager
PC and the Data Host. Of course, there will be
some small differences in data timing as it flows
through the SLNM and it will introduce some data
latencies.

Once the SLNM is operating in this manner, and the
user has opened the appropriate network database
and network, information about the running network
can be obtained through the SLNM.
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1. To obtain diagnostic information about a node,
right click on the node and select the appropriate
diagnostic from the “Diagnostic” entry on the
pop-up menu. Refer also to the Obtaining
Diagnostic Information section.

2. Similarly, the most recently obtained diagnostics
can be viewed. A description of the diagnostic
data can be found in the Diagnostic Commands
section.

3. The user can open a terminal window and
observe the flow of data between the Master
and the application.

4, Also, the user can setup the router to create a
log file which will log traffic, similar to the
terminal window except that it is stored in a file.

The section that discusses problem solving,
provides lots of useful information about using
SLNM to collect ongoing data about the network.
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6 Solving Problems

SolidLink was designed and built to operate reliably
in harsh environments. However, radio networks are
complex and subject to many external variables.
Things will go wrong. This section of the manual will
help the maintenance technologist to:

1. Prepare to make the SolidLink network more
maintainable

2. Solve some common problems, this is by no
means comprehensive, but should provide some
inspiration for solving other problems
encountered

Interpreting diagnostic information

4, Contact Seimac for technical support

6.1 Preparing to Maintain a
SolidLink Network

Before problems occur, there are some things that
should be done to make maintenance and support
easier:

1. Once the network is deployed, establish a
network performance baseline. To do this,
obtain diagnostic status for each radio, at times
when the network appears to be functioning
properly. Statistics should be taken at several
times so that some idea of the variability can be
determined. For example, the propagation
characteristics of a link will vary, and therefore
so will the reported RSSI average.
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Periodically obtain diagnostic parameters from
the network. Compare them against the network
performance baseline and look for trends. For
example, if the reported reflected power was
increasing over time, it might indicate a failing
RF cable.

Have spare SolidLink radio that can be used to
create an ad-hoc network with a suspect radio.
Design a simple two radio test network that does
not interfere with the operational network (has a
different ID, uses a different hop table).
Configure the spare radio as the Master node of
the test network. If a radio is suspect, it can be
loaded in the field with the configuration of the
Remote node of the test network and then
exercised through the test network Master node.

6.2 Addressing Some Common

Problems

6.2.1 Power Light Does Not

[lluminate

The Red LED will illuminate when the SolidLink
radio is provided with adequate DC power.

1

Verify the proper voltage is applied. The voltage
must be between 10 and 26 Volts at the radio.
The 15m data/power cable provided by Seimac
will drop approximately 1V across the cable, so
the user must supply 12V at the cable end.

Page 108
© 2003 by Seimac Limited, All Rights Reserved



SolidLink SS2400S Operators Manual
18 September 2003 Version DRAFT

2. Check the cable continuity with an ohm meter,
the power connector pin outs are described in
the Connectors section.

3. If the problem remains, it is possible that the
firmware has been corrupted. Refer to the
Loading Firmware Updates section for details .

6.2.2 Network Lock Light Does Not
[lluminate

The red power LED is on, but the green network lock
LED, which indicates that the radio has
synchronized with the network, is not illuminated. If
a radio is configured such that it has a network ID,
unit ID and route table, then it automatically try to
achieve network lock when powered up. It will not
do so if it does not have a valid configuration. It is
also important to note that synchronization between
two nodes requires that the downstream node
receive a correct sync packet and that the upstream
node receive a positive ACK. Only then will the two
radios be in sync.

The Unit is a Master

If the unit is a Master, the green LED will flash once
every four seconds, as it transmits a sync packet. If
this does not occur, then most probably the unit is
not configured as a Master. The easiest way to
ensure proper configuration, is to reconfigure the
radio by:

1. Connecting it to the PC running SLNM,
2. Opening the network design
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3. Selecting the Master node and configuring a
radio.

The radio type can also be verified without
reconfiguring by:

1. connect the SolidLink radio to the PC running
SLNM;

2. connect the network manager to the router (refer
to the Router section for details);

3. open aterminal window ;(refer to the Terminal
Window section);

4, put the radio into command mode;

5. in the terminal window type the command
ATl1<cr> and click "Send"; and

6. the radio will respond with its configured type,
which can be seen in the terminal window. 1 =
Master, 2 = Remote, 3 = Repeater.

If the unit is not configured properly, then it should
be reconfigured as the network Master as described
in the Network Configurations section. If the unit is
configured as a Master, but the green LED does not
flash periodically, then contact Seimac Technical
Support.

If the unit is a Master and the green LED is flashing,
it indicates that the Master is trying to synchronize,
but that no downstream radios are responding.
Consider the following:

1. Ensure that the antenna is properly mounted
and connected and if a directional antenna that it
is pointed at the Remote radio.
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2. Ensure that at least one downstream radio is
configured, powered up and within range.

3. Ensure that the output power settings of the
Master and downstream radios are correct
Antenna and Cable Connection.

4. Check the antenna mounts and connections of
the downstream radios.

5. Ensure that the downstream radios are
configured and are powered on (red LED
illuminated).

6. Configure a spare radio as one of the
downstream radios in the network, and locate it
in close proximity (within 50m) to the Master
radio to ensure that path loss is not a problem.

If none of these resolve the problem, then contact
Seimac Technical Support.

The Unit is a Remote or a Repeater

If the radio is a Remote or a Repeater, it will not
flash its green network lock LED. It will not achieve
network lock unless it receives sync packets (on a 4
second cycle) from the upstream radio. The most
likely cause for this is that the unit is not properly
configured. The easiest and most reliable way to
ensure configuration is to reconfigure the radio:

Connecting it to the PC running SLNM;

Opening the network design; and

3. Selecting the proper node from the network
diagram and configuring the radio.
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If configuring the radio does not resolve the problem,
the next most likely problem is that the upstream
radio is not locked. If it is not locked then all radios
downstream of it will not be locked. Check to see
that it is locked using the procedures described in
this section.

If the upstream radio is locked, then the most likely
cause is insufficient received signal at the either the
radio in question or the upstream radio. Consider
the following:

1. ensure that the antenna is properly mounted and
connected and if a directional antenna that it is
pointed at the upstream radio;

2. check the antenna mounts and connections of
the upstream radio;

3. ensure that the upstream radio is configured and
is powered on (red LED illuminated);

4. ensure that the output power settings of the
radio in question and the upstream radio are
correct (refer to the Antenna and Cable
Connection section) and as high as possible;
and

5. reduce the distance between the radio in
qguestion and the upstream radio, or increase the
antenna height (refer to the Estimating RF
Performance section) to improve the link margin.

If none of these resolve the problem, then contact
Seimac Technical Support.
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6.2.3 Radio Does Not Transmit Data

If the SolidLink radio has power and network lock
(green and red LEDs on solid), but the yellow
transmit light does not illuminate; this indicates that
the radio is locked to the network but is not
transmitting data. This situation can also be
determined at the application level, if expected data
from an RTU or other device connected to a radio is
not received. Either way, this indicates that the
radio is not receiving data to transmit, or is not
allowed to transmit because it does not have a
connection.

The easiest way to check this is with an SLNM
connected to the Master radio:

1. Connect the PC running SLNM to the serial port
of the Master radio.

2. Connect to the Router.
3. Open the network design.

4, Select the radio in question on the network
diagram.

5. Obtain a full set of diagnostics for the radio.

This will provide a great deal of information,
described more fully in Interpreting Diagnostic
Information. Among this are serial data receive
count which indicates if serial data is flowing into the
radio and downstream packet receive count which
indicates if data is being received from downstream
nodes (if current radio is a Repeater). Using the
diagnostic menu, the user can clear the counters for
the radio and then determine if data is flowing. Note
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that serial commands and responses are included in
the serial data counts.

If downstream network traffic is expected but not
received, obtain diagnostics for downstream nodes
to determine where the problem lies.

If serial data is expected, the problem will have to be
diagnosed on site. The best way to do this is to
connect a SLNM PC between the RTU (or device)
and the SolidLink radio (refer to the Using SLNM
with a Data Host section).

1. Run SLNM and connect to the Router.
Open a Terminal Window.

3. The serial traffic between the radio and RTU wiill
be displayed on the terminal window. Data
going out to the network is displayed in blue,
incoming data in red.

4. If data is not flowing, probe the CTS line with a
meter or scope (refer to the Data Interface
section).

If CTS is asserted (refer to the Data Mode section)
at +12V, then the RTU is enabled. The problem with
lack of data most probably resides in the RTU or in
the user’s application.

If it is low, then the SolidLink internal serial buffer is
filled and the RTU is blocked.

The most likely reason for this is that the Master has
not created a connection to the radio for some time
in order to flush data. The creation and termination
of connections is under the control of the user’s
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application, it does so by issuing commands to the
Master radio (refer to the Command Mode section).

6.2.4 Radio is Not Accessible Over
the Network

To test for a radio’s accessibility, probe the radio
through SLNM:

1. Connect the PC running SLNM to the serial port
of the Master radio.

2. Connect to the Router.
Opening the network design.

4, Select the radio in question on the network
diagram.

5. Request a full set of diagnostics for the radio.

If the radio is accessible, the diagnostics will be
returned. If not then the user will see a dialog box
indicating that the SLNM timed out waiting for a
response.

If the upstream radio supports multiple downstream
radios, then its diagnostic information will not be
particularly useful because it is not possible to
isolate the performance of a single link. However, if
the upstream radio supports only one downstream
radio (the inaccessible unit), then it is useful to
obtain diagnostics for the upstream radio, following
the directions above.

Look at the downstream RSSI, this will provide an
indication of the strength of the received signal (refer
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to the Interpreting Diagnostic Information section) .
If they are abnormally low, then this is an indication
of an impending link failure. Also look at the
downstream received packet count. Reset the
counters and see if it increases.

The most likely cause for failure is a cable or
antenna problem. If the upstream radio is
accessible, the problem is likely at the inaccessible
radio. Visit the site and troubleshoot as per (refer to
the Power Light Does Not llluminate and Network
Lock Light Does Not llluminate sections) . Once the
radio is locked to the network, then it will be
accessible.

6.2.5 Link Performance Decreasing

By monitoring RSSI values for the network radios,
the user can see if link performance is decreasing.
This will be indicated by reducing values of RSSI
(refer to the Interpreting Diagnostic Information).

This will be most likely caused by deterioration in the
antenna or cable system. From the Master node,
obtain diagnostics for the two radios at either end of
the link (refer to the Obtaining Diagnostic
Information section). Observe the SWR fault count,
and forward and reflected power readings in the
SolidLink radio.

=  SWR fault counts an high reflected power
readings indicate a problem in the antenna or
cabling system. Possibly a cable or connector
has been damaged.
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= Low forward power indicates that the transmitter
is loosing power, likely an internal failure.
Contact Seimac Technical support as described
in Getting Help From Seimac.

Another possible cause is that the antenna has
become misaligned because its physical mount has
failed.

6.2.6 Some Data is Missing

SolidLink radios ensure the integrity of data by
adding a checksum to each packet and then
comparing the checksum with the recalculated value
upon receipt. There is a very high probability that
this system will detect errors. Packets with errors
are automatically retransmitted up to a user
selectable retry limit at which time the packet is
discarded.

Data can be “missed” for two reasons:

1. Alink margin is low or there is interference on a
link which causes a temporary loss of reliable
connection. Packets are retried to the maximum
limit and then discarded. The information that
would have been transmitted is lost. The user
can determine this by obtaining diagnostics on
all relevant radios in the network and observing
the upstream and downstream dropped packet
count.

2. The RTU was blocked from sending serial data
and has been forced to drop some information.
In a point-to-point network, Remote or
Repeaters transmit serial data only when there
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is a connection to the Master radio. This is set-
up by the user’s application connected to the
Master (refer to the Operating Modes section).

If a SolidLink serial buffer fills, it will drop its CTS
line (refer to the Data Mode section) and
therefore block the RTU. If the RTU remains
blocked beyond its ability to buffer data, then
information will be lost.

6.3 Interpreting Diagnostic
Information

As described in the Diagnostic Commands section,
SolidLink provides a set if diagnostic information that
can aid component and network troubleshooting.
Often parameters are available for both receive and
transmit (such as packet count) and for upstream
and downstream connections. Upstream is towards
the Master, downstream away from the Master.

A radio can have only one upstream connection, so
it is clear to which link upstream information refers.
Master and Repeaters can have multiple
downstream connections, and the statistics that refer
to downstream connections (again such as packet
count) refer the all downstream links. For example,
the downstream transmitted packet count refers to
the count of all packets transmitted to all
downstream radios.

Counters can be cleared by diagnostic command,
and the effect is immediate.
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Diagnostics can be grouped into several categories:

1. RF performance;

2. Network performance;
3. Packet counters; and
4

Serial data counters.
6.3.1 RF Performance

The SolidLink radio RF circuitry includes devices
that measure both the forward transmitted power
and the power reflected back from the antenna.
Ideally, the antenna is perfectly matched and
reflected power is zero, however a match is never
perfect. Measurements are made during the initial
portion of each transmission.

Received Signal Strength Indicator (RSSI)

The received signal strength is measured during
each received packet. Assuming the transmitter
stays constant, RSSI will vary as the transmission
channel changes, due to interference, atmospheric
conditions etc. RSSI varies from 1 to 10, where 1 is
a very weak signal and 10 is very strong.

Forward Power

This is a measure of the power transmitted in
milliwatts.
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Reflected Power

This is a measure of power reflected from the
antenna in milliwatts.

SWR Fault Count

The forward and reflected power measurements
made during each transmission are used to
calculate a mismatch, as a standing wave ratio. If
the mismatch exceeds 3-1 then SolidLink declares a
fault and counts the event. Generally, this indicates
an antenna or cable problem.

6.3.2 Network Performance

Network Dropout Count

A network dropouts occurs when the radio looses
synchronization with the upstream node in the
network. After a radio synchronizes with the
upstream radio, it hops in sync with that radio. While
there may be no data, there will always be a
synchronization packet nominally each 4 seconds. If
radio does not see a synchronization packet when
expected, it dropped out of sync (quite possibly the
problem exists upstream) and counts the event. The
green network lock LED will illuminate. It will then
try to recover network lock.
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6.3.3 Packet Counters
SolidLink counts five different packets:

Transmit Packet Count

The upstream and downstream transmit packet
counters contain the number of packets that were
transmitted since the counters were cleared.

Received Packet Count

The upstream and downstream receive packet
counters contain the number of packets that were
received since the counters were cleared.

Rejected Packet Count

The upstream and downstream rejected packet
counters contain the number of packets that were
rejected since the counters were cleared. Packets
are rejected when their calculated checksum does
not match the checksum transmitted at the end of
the packet.

Dropped Packet Count

The dropped packet count is the number of
transmitted packets that were dropped because the
maximum number of retries expired.
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Duplicate Packet Count

The duplicate packet count is the number of
duplicate packets received.

6.3.4 Serial Data Counters

The SolidLink radio provides two serial data
counters:

Serial Data Transmit Count

The serial data transmit counter contains the
number of bytes transmitted out the serial port since
the counter was cleared. It includes all characters
sent in command mode.

Serial Data Receive Count

The serial data receive counter contains the number
of bytes received in the serial port since the counter
was cleared. It includes all characters received in
command mode.

6.4 Getting Help From Seimac

Seimac Limited is proud to stand behind their
products.

The latest information about Solid Link can be
obtained on the product web site:
www.solidlinkradio.com.
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The Seimac technical support team is available to
answer any questions and provide assistance to
resolve problems. They can be contacted as
follows:

Phone - (902) 468-3007
Fax - (902) 468-3009
Email - techsupport@seimac.com

Before returning any product to Seimac, a Return
Materials Authorization (RMA) number must be
obtained. This should be done by contacting Seimac
Technical Support as listed above. Once an RMA
number is obtained, the material should be shipped
to:

Seimac Limited

271 Brownlow Avenue
Dartmouth, NS
Canada

B3B 1W6

Attention: Technical Support

RMA#. nnnnnnnn
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7 System Specifications

Transmitter

Transmit Frequencies
Transmit Power

Modulation Type

2.4 - 24835 GHz
100mW - 1 Watt Adjustable

GMSK

Receiver Receive Frequencies 2.4 -2.4835 GHz
Sensitivity -104 dB@10° BER
Selectivity

Power Supply [Power Supply Voltage 10 - 26 VDC
Power Supply Current

Transmitf 500 mA (at 12 volts nominal)

Receive

Sleep)

50 mA (at 12 volts nominal)

<ImA

Data
Communicatio
ns

Serial Baud Rate
Parity
Flow Control

Error Correction (over the
air)

Hardware Data Interface

1200 - 57,600 bps

none, even, odd

CTS (output)

32 Bit CRC; resend on error

RS-232

Network

Max. Sustained Serial Data
Rate without Repeaters

57,600 bps
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Max. Sustained Serial Data (28,800 bps
Rate
Frequency Hopping
Spectrum Spreading Point-to-point; point-to-
Configuration multipoint w ith or without
Repeaters
Environmental |Operating Temperature -40°C to +75°C -40°F to
Range +165°F
Vibration In accordance with MIL STD
810
Shock
In accordance with MIL STD
Humidity 810
Waterproof 100%
Submersible to 12"
Mechanical Dimensions 6.5"x3.5"x2"
(16.5cmx9.9cmx5.1cm)
Weight
1.1Ib (499.4 grams)
Mounting
1/4" - 20 UNC, two on sliding
track for various RTU, 19" rack
and mast/pole mounting
Certifications |US FCC (Pending)
Canada Industry Canada (Pending)

Patents Pending
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8 Glossary

Master — The controlling industrial radio modem. All
communication is between this industrial radio
modem and the Remotes. This industrial radio
modem controls hop-timing for the network.

Point-to-point — A network where the Master
industrial radio modem unit communicates to one
Remote at a time.

Point-to-multipoint — A network where the Master
industrial radio modem communicates to all
Remotes at the same time. Only one Remote
industrial radio modem at a time may communicate
to the Master.

Remote - A Remote industrial radio modem is one
that links with the Master and sends data to it.

Repeater - This industrial radio modem may repeat
data from the Master to a Remote or to another
Repeater. It is used
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9 Index
TBD
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10 Warranty Registration
Card

TBD
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ANNEX A: COMMANDS
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Commands

As discussed in the Data Interface section, the
SolidLink radio supports a command mode whereby
it accepts commands at its serial interface port. The
procedure for entering command modes is
described in the Command Mode section.

All commands are issued by the controlling device
as ASCII strings starting with the ASCII characters
“AT". This is immediately followed by the command
type and then any qualifying arguments. The
command arguments may be variable in length. The
entire command string must be terminated with a
carriage return (0Oxd), denoted here by <cr>.

The radio will respond with an ACK if the command
is accepted and with a NAK if the command is
rejected. ACK consists of the ASCII string “OK<cr>".
If the command returns a value, it will arrive after the
ACK and will also be terminated by a carriage
return. NAK consists of the ASCII string “-nn<cr>"
where nn is a one or two digit error code.

1. All alphabetic characters must be in upper case.

2. All numeric characters are decimal.

3. All fields are fixed width and must include
leading zeroes if necessary.

The following illustrates a typical dialog:
ATI2<cr> 3 controlling device requests unit type
OK<cr> RBradio responds with ACK

1<cr> RBradio responds with type indicating it is a
Master
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In the following tables, the term attached unit or
radio refers to the SolidLink radio who's serial port is
connected to the controlling unit and which is directly
receiving commands. The term addressed unit or
radio refers to a radio with which a connection has
been made. It is important to remember that only
the Master radio can create a connection with
another radio (ATDT command).

Command Attention
Description Determine that the radio is in command
mode
Format AT
Arguments none
Return none
Command Create a Connection
Description Create a virtual connection between the
Master and another radio in the network.
Format ATDT
Arguments dddd
dddd = radio id humber
if dddd is zero, then the connection is
made to all radios in the network
Return none
Command Terminate a Connection
Description Terminate a previously opened connection
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Format ATHO
Arguments none
Return none
Command Get Lock Status
Description Determine if the attached radio is locked to
the network
Format AT\S
Arguments none
Return 1 = radio is locked
0 = radio is not locked
Command Get Currently Addressed Unit
Description Return the id of the radio to which a current
connection is made.
Format ATIO
Arguments none
Return nnddddd
nn = network number
dddd = radio id number
Command Get Unit Type
Description Return the type of the attached radio
Format ATI1
Arguments none
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Return t
t = 1 if unit is a Master
t = 2 if unit is a Remote
t = 3 if unit is a Repeater|
Command Get Firmware Version
Description Return a string containing the firmware
revision identifier
Format ATI2
Arguments none
Return DSDD-DDD-DD VD.D
Command Get Unit ID
Description Return the ID of the attached radio
Format ATI3
Arguments none
Return nndddd
nn = network number
dddd = radio id number
Command Exit Command Mode
Description Exit command mode, returning to data
mode
Format ATQ
Arguments none
Return none
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Diagnostic Commands

SolidLink radios also support a suite of diagnostic
commands. These are used to determine the status
of any radio in the network and to monitor network
performance. Each SolidLink radio maintains a set
of event counters and measured values that provide
a indication of its own performance and the
performance of the RF links to neighboring SolidLink
radios. The commands follow the same protocols as
do the standard commands.

Diagnostic commands all have the form:
ATDMxxnndddd
Where:

XX is a two digit diagnostic command
identifier

nn is the network ID

dddd is the unit ID for which
information is requested

Command Upstream RSSI
Description Get the upstream link RSSI value,
averaged over the last 10 received packets.
Command 01
Return dddddddddd

dddddddddd = average RSSI in millivolts.
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Command Downstream RSSI
Description Get the downstream link RSSI value,
averaged over the last 10 received packets.
Command 02
Return dddddddddd
dddddddddd = average RSSI in millivolts.
Command Upstream Rejected Packet Count
Description Get the number of rejected packets
(checksum mismatch) on the upstream link.
Command 03
Return dddddddddd
dddddddddd = number of packets
Command Downstream Rejected Packet Count
Description Get the number of rejected packets
(checksum mismatch) on the downstream
link.
Command 04
Return dddddddddd
dddddddddd = number of packets
Command Upstream Received Packet Count
Description Get the number of packets received on the
upstream link.
Command 05
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Return dddddddddd
dddddddddd = number of packets
Command Downstream Received Packet Count
Description Get the number of packets received on the
downstream link.
Command 06
Return dddddddddd
dddddddddd = number of packets
Command Upstream Transmit Packet Count
Description Get the number of packets transmitted on
the upstream link.
Command 07
Return dddddddddd
dddddddddd = number of packets
Command Downstream Transmit Packet Count
Description Get the number of packets transmitted on
the downstream link.
Command 08
Return dddddddddd
dddddddddd = number of packets
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Command Network Dropout Count
Description Get the number of times that the radio has
lost network lock.
Command 09
Return dddddddddd
dddddddddd = number of dropouts
Command SWR Fault Count
Description Return the number of SWR faults.
Command 10
Return dddddddddd
dddddddddd = number of dropouts
Command Forward Power
Description Get the reading from the forward power
sensor, taken at last transmission.
Command 12
Return dddddddddd
dddddddddd = millivolts from 0 - 1023
Command Reflected Power
Description Get the reading from the reflected power
sensor, taken at last transmission.
Command 13
Return dddddddddd
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dddddddddd = millivolts from 0 - 1023

Command Route Table
Description Get the entire route table, this command
always returns the route table of the
attached radio.
Command 15
Return ddd1,ddd2...ddde <1000 values>
ddd1 = position 1 entry
ddd2 = position 2 entry
ddde = position 1000 entry
Command Dump Diagnostics
Description Get results from all diagnostic commands,
except 15-Route Table.
Command 16
Return Results from all diagnostics are provided
sequentially, each separated by a comma.
They are ordered by command ID.
Command Downstream Dropped Packet Count
Description Get the number packets dropped from the
downstream link.
Command 17
Return dddddddddd

dddddddddd = number of packets dropped
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Command Upstream Dropped Packet Count
Description Get the number packets dropped from the
upstream link.
Command 18
Return dddddddddd
dddddddddd = number of packets dropped
Command Clear Diagnostic Counters
Description Set the diagnostic counters to zero.
Command 19
Return none
Command Serial Data Transmit Count
Description Get the number of bytes sent out the serial
port.
Command 20
Return dddddddddd
dddddddddd = number of bytes
Command Upstream Duplicate Packet Count
Description Get the number of duplicate packets
received on the upstream link.
Command 21
Return dddddddddd
dddddddddd = packet count
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Command Downstream Duplicate Packet Count
Description Get the number of duplicate packets
received on the downstream link.
Command 22
Return dddddddddd
dddddddddd = packet count
Command Serial Data Received Count
Description Get the number of bytes received in the
serial port.
Command 23
Return dddddddddd
dddddddddd = number of bytes
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